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LỜI NÓI ĐẦU 
 
 

 Giáo trình ỨNG DỤNG TIN HỌC TRONG SẢN XUẤT CHƯƠNG 
TRÌNH TRUYỀN HÌNH này là một trong những sản phẩm thuộc Đề tài nghiên 
cứu khoa học và phát triển công nghệ "Nghiên cứu cải tiến cương trình đào tạo tin 
học ứng dụng trong việc sản xuất chương trình phát thanh, truyền hình" do Trường 
Cao đẳng Phát thanh – Truyền hình II, Đài Tiếng Nói Việt Nam chủ trì nghiên cứu 
trong năm 2006. Giáo trình này, sau khi được thẩm định và nghiệm thu, sẽ được đề 
nghị làm tài liệu giảng dạy và học tập cho môn học (hoặc khóa học ngắn hạn) tương 
ứng tại trường. Giáo trình cũng được thiết kế phù hợp với hình thức vừa học vừa 
làm tại các đài (hoặc trạm) phát thanh truyền hình và hình thức tự học. Để nâng cao 
chất lượng và hiệu quả đào tạo, giáo trình được biên soạn phù hợp với các phương 
pháp giảng dạy và học tập tích cực, lấy học viên làm trung tâm và thiên về kỹ năng 
thực hành như: phương pháp đào tạo ngay trên công việc, phương pháp học thông 
qua làm, phương pháp kèm cặp… Học viên cũng có thể sử dụng giáo trình này để 
tự học ngay trên máy vi tính. 

 Về nội dung, giáo trình được biên soạn dựa trên hai phần mềm dựng Video 
thông dụng là Adobe Premiere Pro 1.5 và Ulead Video Studio 9.0, tương ứng với 2 
phần chính, thích hợp với thời gian giảng dạy và học tập khoảng 60 tiết (bao gồm cả 
thời gian làm bài thực tập và kiểm tra đánh giá kết quả học tập). Phần Adobe 
Premiere Pro 1.5 do Trần Minh Hùng biên soạn. Phần Ulead Video Studio 9.0 do 
Hà Nguyễn Phương biên soạn. Kèm theo giáo trình này, còn phần mềm thi trắc 
nghiệm, chấm điểm tự động do Trần Minh Hùng viết và các tập tin video để làm bài 
tập thực hành. Nguyễn Quốc Anh chịu trách nhiệm biên tập và hiệu đính toàn bộ 
giáo trình.  

 Giáo trình này được biên soạn lần đầu, nên chắc chắn không tránh khỏi một số 
thiếu sót nhất định. Nhóm thực hiện đề tài chân thành cảm ơn mọi ý kiến đóng góp 
của giáo viên và học viên để giáo trình ngày càng hoàn thiện hơn. Thư góp ý xin gửi 
về địa chỉ Email: trg-ptth2@hcm.vnn.vn. 

 
 
 NHÓM THỰC HIỆN ĐỀ TÀI 
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PHẦN 1: 

PHẦN MỀM  

ULEAD VIDEO STUDIO 9.0 

 

NỘI DUNG THỜI LƯỢNG 

Bài 1 : Giới thiệu 2 tiết 

Bài 2 : Làm việc với Project 3 tiết 

Bài 3 : Biên tập Video 5 tiết 

Bài 4 : Chuyển cảnh 5 tiết 

Bài 5 : Tạo chuyển động 5 tiết 

Bài 6 : Kỹ xảo 5 tiết 

Bài 7 : Cách tạo chữ 5 tiết 

Bài 8 : Capture và xuất Video 5 tiết 

Tổng số 35 tiết 
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BÀI 1 

GIỚI THIỆU 

 
 
Mục tiêu: 

- Giúp học viên có cái nhìn khái quát chương trình biên tập và dựng 
video của hãng Ulead chương trình Video Studio 9.0.  

- Cách khởi động chương trình Ulead Video Studio 9.0 

- Tìm hiểu về giao diện chương trình (Cửa sổ Galery, Monitor, Time 
Line, bảng Option, Step Panel và Menu).  

- Tìm hiểu các chức năng, nhiệm vụ chính của từng phần giao diện. 

 

Thời gian thực hiện 

 2 tiết hoàn thành, kể cả thời gian thực tập. 

 



 
 
Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 5 
 
 
 

1.1. Giới thiệu chung 

Ulead Video Studio 9.0 là một chương trình xử lý, biên tập phim ảnh phổ thông 
dùng cho tất cả mọi người chập chững bước vào lĩnh vực biên tập, dựng phim.  Đây 
là một chương trình cơ bản về biên tập Video. Trong Ulead Video Studio 9.0 hầu như mọi 
công cụ  đều đơn giản, nó giúp cho những người chưa biết gì về biên tập dựng phim , cũng  
có thể thực hiện các ý tưởng của mình. 

Ulead Video Studio 9.0 là công cụ hỗ trợ người dùng hơn là một công cụ kỹ 
thuật cao, mặt dù vậy nó cũng tạo ra hình ảnh và âm thanh theo cách nhìn mới, 
mang tính chuyên nghiệp hơn, thực hiện nhiều đề án ngắn và dài theo tiêu chuẩn 
chính xác. 

Ulead Video Studio 9.0 có một giao diện, môi trường làm việc tiện lợi và quen 
thuộc cho phép dựng nhiều kết quả chính xác trong mỗi lần dựng; tạo ra nhiều đề án 
hợp lý, điều chỉnh màu sắc một cách dễ dàng; biên tập chính xác; làm việc thuận tiện 
với hình ảnh, video số và xuất thành phim. 

Phần mềm Ulead Video Studio 9.0 là một phần mềm khá đơn giản tuy nhiên 
nó cũng  đòi hỏi  người dùng phải có một kiến thức đầy đủ về điện ảnh và truyền 
hình. Trong tài liệu này sẽ cho chúng ta một cái nhìn tổng quát nhất, cơ bản nhất về 
phần mềm dựng phi tuyến Ulead Video Studio 9.0 để từ đó chúng ta có thể hiểu 
được và tạo ra được những sản phẩm đẹp mắt như mong muốn, đồng thời nó cũng 
là một nền tảng cơ bản cho những người quan tâm đến các phần mềm dựng, biên 
tập Video để sau này có thể dể dàng tiếp thu các phần mềm dựng phức tạp và 
chuyên nghiệp hơn như:  Adobe Premiere Pro 1.5, Liquid…. 
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1.2. Khởi động chương trình Ulead Video Studio 9.0 

Nhấp đúp chuột vào biểu tượng Ulead Video Studio 9.0 trên màn hình (hình 1) 
hoặc Chọn Start > Programs > Ulead Video Studio 9.0 

 

 
Hình  1 

 

Hộp thoại xuất hiện:  

Ulead Video Studio 9.0 là phiên bản được nâng cấp rất nhiều so với các phiên 
bản trước đó, để bắt đầu vào chương trình, ta phải click chọn VideoStudio Editor để 
vào giao diện chính của chương trình. Nếu click vào DV-to-DVD Wizard thì ta sẽ 
vào cửa sổ để scan hay để capture các đoạn video từ máy quay vào trong thư viện 
hình. Nếu click chọn Movie Wizard thì ta sẽ vào cửa sổ để insert hình ảnh, âm 
thanh có trong máy tính vào thư viện hình.  (hình 2). 

 

 

Hình  2 
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1.3. Giao diện 

Màn hình giao diện của Ulead Video Studio 9.0 gồm : 

 

Hình  3 

 

1- Cửa sổ Gallery 

Là nơi lưu trữ tất cả các đoạn 
Clip Video, Audio, các file ảnh tĩnh  
được lấy ra bằng cách Import hoặc 
Capture từ băng hay Camera, có thể 
thêm hoặc bỏ các đoạn Clip mà ta đã 
đưa vào. 

Trong Gallery có chứa bảng 
Video Filter để thực hiện các kỹ xảo 
và các chuyển cảnh trong Video 
ngoài ra còn có phần Title dùng để 
thêm chữ vào Video hay các Clip 
hình. 

 

Hình  4 
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2- Monitor Window:  

Cửa sổ này có hai trạng thái thể hiện là: Project và Clip  

Khi click vào Clip thì ta sẽ xem riêng một Clip và có thể đánh dấu các điểm 
cần thiết để cắt hình.  

Khi click vào Project thì ta sẽ xem trạng thái hiện tại của các Clip đang được 
dựng trên cửa sổ Timeline. 

 

Hình  5 

 

3- Timeline Window: 

Cho ta thấy tất cả các track Video, track Audio. Các thay đổi trên các track sẽ 
được hiển thị trên màn hình Monitor Window khi ta click vào trạng thái Project. 
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1: Track video : dùng đặt video 
2: Track Overlay : dùng để chồng hình 
3: Zoom out : kéo dãn theo chiều ngang 
4: Con trượt zoom 
5: Zoom in : thu hẹp theo chiều ngang 
6: Thanh thời gian 
7: Track title : dùng để đặt chữ 
 8: Track voice : dùng để đặt âm thanh thu từ ngoài 
 9: Track music : dùng để đặt tập tin âm thanh 

 

4- Bảng Option Panel: 

Trình bày thông tin về một Clip được 
chọn hoặc các thông tin về kỹ xảo, chuyển 
cảnh để ta có thể biên tập, thay đổi các thông 
số về thời gian, màu sắc v.v… (hình 7). 

 

 
Hình  7 
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5 
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1 
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2 
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5- Thanh Step Panel 

Đây là thanh chứa các nút dùng để chuyển nhanh đến các trạng thái khác nhau 
khi ta biên tập video. 

 

 

Hình  8 

 
6- Thanh Menu 

Menu trong Ulead Video Studio 9 cũng giống như phần lớn các phần mềm 
ứng dụng khác. Menu của Ulead Video Studio 9 bao gồm các lệnh phổ biến như: 
Save, Open, New…… ngoài ra còn có các lệnh thành phần riêng khác của phần 
mềm Ulead Video Studio 9. 

 

 

Hình  9 

 

1.4. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Khái niệm về một chương trình biên tập Video mà cụ thể là chương trình 
Ulead Video Studio 9.0 

- Cách khởi động chương trình Ulead Video Studio 9.0 

- Tìm hiểu về giao diện và chức năng của từng phần trong trong giao diện 
chương trình (Cửa sổ Galery, Monitor, Time Line, bảng Option, Step Panel và 
Menu).  

 

Câu hỏi ôn tập 

- Có bao nhiêu cách để khởi động chương trình ? Hãy trình bày. 

- Trình bày các thành phần của giao diện chương trình và các chức năng. 
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BÀI 2 

LÀM VIỆC VỚI PROJECT 

 
Mục tiêu: 

- Tìm hiểu về khái niệm Project (dự án) 

- Thực hiện các thao tác cơ bản 

+ Tạo Project 

+ Lưu Project 

+ Mở Project 

+ Import Clip vào Project 

+ Sắp xếp các Clip trên Timeline 

Thời gian thực hiện 

 3 tiết hoàn thành, kể cả thời gian thực tập. 
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2.1. Khái niệm 

Project là một dự án làm phim trong Ulead Video Studio 9.0, lưu trữ tất cả các 
đoạn Clip khác nhau và chứa đựng những thông tin về cách sắp xếp chúng. Trong 
một file của Project, ta có thể kết hợp nhiều cảnh riêng lẻ thành một chương trình 
hoàn chỉnh bằng cách chuyển cảnh, thực hiện kỹ xảo, các phép chồng hình, ghép 
hình hoặc trộn âm thanh… 

 

2.2. Tạo Project mới: 

Thực hiện cách sau: 

 - Chọn File > New  Project. Khi hộp thoại New Project xuất hiện thì thực 
hiện một trong những cách sau: 

 - Lúc này ta sẽ có một 
project mới theo chuẩn mà lúc cài 
đặt chương trình ta đã chọn. 

 - Nếu muốn thay đổi sự mặt 
định này để có thể thực hiện theo 
đúng ý ta muốn dùng để xuất ra 
các chuẩn video khác nhau thì ta 
làm như sau: Chọn File >  Project 
properties 

 - Sau đó ta chọn Edit 

 
Hình  10 

 

  + Biên tập Video chuẩn băng số. Kích thước khung hình mặc định 
là  720 x 480 (cho hệ NTSC) và 720 x 576 (cho hệ PAL) 

  + Biên tập Video theo chế độ theo chuẩn của Window. Kích thước 
 mặc định là 320 x 240 (NTSC) và 352 x 288 (PAL). 
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 - Frame size: kích thước khung hình:  

  + 720 x 480 (cho hệ NTSC chuẩn DV) 

  + 720 x 576 (cho hệ PAL chuẩn DV),  

  + 320 x 240 (NTSC) 

  + 352 x 288 (PAL).  
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2.3. Lưu một Project 

Để lưu một Project: 

- Vào Menu File > Save để lưu Project đang mở. 

- Để lưu sao chép (lưu với tên khác) một dự án và tiếp tục làm việc trong bản 
sao chép mới thì chọn File > Save as, rồi chọn nơi muốn lưu và đặt tên cho tập tin, 
sau đó click vào nút Save.  

- Tập tin của project sẽ có phần mở rộng là VSP 

 
Hình  12 
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2.4. Mở một Project 

Để mở một Project thì chọn 
File > Open Project. Tìm đến nơi 
chứa Project và chọn Project muốn 
mở rồi Click Open. 

 
Hình  13 

 

2.5. Nhập Clip vào Project 

- Để đưa các Clip đã lưu trên ổ đĩa vào Project ta thực hiện một trong những 
cách sau: 

- Vào menu File chọn insert media to timeline > video . 

 

 

Hình 14 
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- Cửa sổ Insert xuất hiện. Chọn nơi lưu trữ các Clip để mở. 

- Ngoài ra ta còn có thể insert các đoạn hình ảnh âm thanh vào trước trong 
gallery để tiện cho việc biên tập bằng cách vào menu File chọn insert media to 
gallery> video, audio, piture…… 
 

 

- Nếu chọn nhiều Clip liên tiếp nhau thì nhấn giữ phím Shift trong khi chọn. 

- Nếu chọn nhiều Clip không liên tiếp nhau thì nhấn giữ phím Ctrl trong khi chọn. 

- Nhấn nút Open để Import. 

 
Hình  15 
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2.6. Sắp xếp các Clip trên Timeline 

Để sắp xếp các Clip lên Timeline ta thực hiện như sau: 

- Chọn một hoặc nhiều Clip trên cửa sổ Gallery. 

- Kéo các Clip đã chọn thả các track Video hoặc Audio tương ứng trên cửa 
sổ Timeline. 

 

 

Hình  16 

 

2.7. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Tìm hiểu về khái niệm Project (dự án) 

- Thực hiện các thao tác cơ bản với Project như : New Project, Save, 
Open Project, Import, … 

 
Câu hỏi ôn tập 

- Trình bày khái niệm về Project (dự án). Tạo Project luôn là thao tác đầu tiên, 
đúng hay sai ? Vì sao ? 

- Trong thao tác tạo mới một Project cần quan tâm đến điều gì ? 

- Tập tin project sẽ có phần mở rộng là gì ? 

- Khi thực hiện lệnh nhập Clip vào project ta có thể chọn tập tin project được 
không ?  
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Bài tập 

1- Khởi động chương trình Ulead Video Studio 9.0 

2- Tạo một dự án (Project) mới với tên baitap1. vsp 

3- Import một Clip vào Timeline 

4- Đặt Clip track Video 1 cửa sổ Timeline 

5- Lưu dự án đã tạo. 

6- Lưu dự án với tên mới là  baitap2.vsp 
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BÀI 3 

BIÊN TẬP VIDEO 

 
Mục tiêu: 

- Thao tác biên tập điểm In – Out 

- Chọn Clip 

- Di chuyển các Clip 

- Thay đổi tốc độ của Clip 

 

Thời gian thực hiện 

 5 tiết hoàn thành, kể cả thời gian thực tập. 
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3.1. Biên tập điểm IN - OUT 

- Trên cửa sổ Option Panel chọn Multi - trim video 

- Di chuyển thanh trượt đến điểm cần đánh dấu. 

- Chọn Start làm điểm bắt đầu, và chọn End làm điểm kết thúc (đây là hai 
điểm Mark in và Mark out của đoạn video mà ta cần). 

- Đoạn video mà chúng ta có được là đoạn video nằm giữa hai dấu Mark In 
và Mark Out 
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3.2. Chọn một hoặc nhiều Clip 

- Chọn một Clip, click vào Clip muốn chọn trên cửa sổ Timeline. 

- Để chọn nhiều Clip, dùng nhấn Shift và click vào đoạn Clip muốn chọn. 

 

 

Hình  18 

 

3.3. Di chuyển các Clip 

1- Chuyển động Clip trong Timeline 

Nói chung, việc di chuyển một Clip đơn giản là bấm giữ chuột trái và kéo rê 
nó tới bất kỳ vùng nào trong track sao cho nó đến vị trí  thích hợp. Đây là thao tác 
cơ bản đầu tiên để dựng một đoạn video đơn giản.  

Lưu ý: Khi ghép các đoạn Video cần cẩn thận khoảng trắng giữa các đoạn. 

 

2- Để di chuyển một Clip tới một điểm trước hoặc  sau trong Timeline : 

Kéo Clip sang trái hoặc phải, và định vị Clip bằng cách quan sát hình chữ nhật 
mờ đại diện thời lượng của Clip.  

 

3- Để di chuyển một Clip tới một track khác: 

Kéo Clip lên hoặc xuống vào track ta muốn. 
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3.4. Chỉnh tốc độ của các Clip 

- Chọn Clip. 

- Chọn Playback Speed, trong cửa sổ này chọn giá trị speed (tốc độ) thích 
hợp để cho Clip này phát nhanh hay chậm theo ý muốn. 
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3.5. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Cách thực hiện đánh dấu Mark In và Mark Out 

- Thực hiện chọn và di chuyển sắp xếp các Clip 

- Thay đổi tốc độ cho các Clip 

 
Câu hỏi ôn tập 

- Để thực hiện đánh dấu Mark In – Mark Out ta bấm vào nút gì, trong vùng 
làm việc nào ? 

- Thực hiện di chuyển các đoạn Clip ta cần chú ý điều gì ? 

- Hãy ứng dụng vào thực tế hiệu ứng thay đổi tốc độ của Clip. 
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BÀI 4 

CHUYỂN CẢNH 

 
Mục tiêu: 

- Khái niệm cơ bản về chuyển cảnh 

- Các thao tác cơ bản  

 

Thời gian thực hiện 

 5 tiết hoàn thành, kể cả thời gian thực tập. 
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4.1. Khái niệm 

Đây là phần kỹ xảo giúp khắc phục những đoạn gây khó chịu khi chúng ta 
thực hiện việc cắt dán, để tạo ra những chuyển cảnh đẹp, gây cảm giác dễ chịu, 
hướng thú cho người xem. 

 

4.2. Các thao tác cơ bản 

1- Các bước thực hiện chuyển cảnh. 

 - Chọn và kéo 2 Clip hình ảnh từ cửa sổ Gallery thả xuống cửa sổ Timeline, hình 
ảnh sẽ được đặt theo thứ tự trong cửa sổ Timeline. 
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 - Vào gallery 
rồi Click chọn nút 
gallery (mũi tên) để 
chọn Transitions, 
click vào nhóm 
chuyển cảnh cần 
chèn. 

 - Kéo và thả 
chuyển cảnh đã chọn 
xuống cửa sổ 
Timeline để đưa vào 
điểm tiếp nối giữa 2 
Clip. 
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- Nhấn nút  để xem chuyển cảnh trên cửa sổ Monitor. 

 

2- Điều chỉnh chuyển cảnh. 

 - Click chọn đoạn chuyển cảnh 

 - Tại cửa sổ Option Panel click chọn nút Customize thì một cửa sổ điều chỉnh 
các thông số của  chuyển cảnh sẽ hiện ra. Ta điều chỉnh các thông số này sao cho hợp lý. 

 - Lưu ý các cửa sổ điều chỉnh này rất khác nhau tùy từng loại chuyển cảnh mà 
ta sử dụng  
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Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 25 
 
 
3- Các chuyển cảnh được sử dụng trong Ulead Video Studio 9.0 

3D Motion : các chuyển cảnh 3D. Clock : chuyển cảnh như kim đồng hồ xoay 

Album : chuyển cảnh như lật album Build: chuyển cảnh theo từng ô hay từng hàng 

Flashback : lóe sáng của đèn flash Mask : dạng mặt nạ chồng hình 

Peel : lật trang Slide : đường trượt 

F/X : một số kỹ xảo đặc biệt Stretch : sự duỗi ra 

Wipe : quét hình Rotate : các chuyển cảnh xoay 

 

4.7. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Khái niệm cơ bản về chuyển cảnh 

- Các thao tác cơ bản về chuyển cảnh 

 + Áp dụng kỹ xảo chuyển cảnh 

 + Hiệu chỉnh kỹ xảo chuyển cảnh 

 + Các nhóm chuyển cảnh của chương trình 

 

Câu hỏi ôn tập 

- Kỹ xảo chuyển cảnh giúp người biên tập video khắc phục điều gì ? Điều 
này ở thực tế có thật sự quan trọng hay không ? 

- Kỹ xảo chuyển cảnh có thể thực hiện được trên 1 đoạn Clip không ? Giải 
thích vì sao. 
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BÀI 5  

TẠO CHUYỂN ĐỘNG 

 
 
 
Mục tiêu: 

Thực hiện các chuyển động của Clip  

 

Thời gian thực hiện 

 5 tiết hoàn thành, kể cả thời gian thực tập. 
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5.1. Tạo chuyển động 

- Việc chuyển động của các Clip trong Ulead Video Studio 9.0 là khá đơn 
giản nên ta có thể thực hiện nó một cách dễ dàng tuy nhiên chính vì vậy mà nó 
không thể đáp ứng được việc thực hiện các chuyển động phức tạp như các phần 
mền dựng phi tuyến khác. 

- Click chọn hình ảnh trên cửa sổ Gallery, đưa xuống Timeline và đặt trên 
track overlay.  

 

Lưu ý: chỉ có các đoạn video được đặt trên track overlay mới có thể chuyển 
động được 

 

- Click vào Clip được chọn làm chuyển động. 

- Sau đó trên cửa sổ Option Panel chọn thẻ Attribute. 
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- Click chọn bản Enter một vị trí như hình trên để xác định vị trí ban đầu của 
Clip video, sao đó chọn vị trí cho bản Exit để xác định vị trí di chuyển lúc kết thúc của 
Clip video. 

- Sau khi chọn xong ta có được kết quả di chuyển của Clip thư hình sau: 
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- Lập lại hai bước trên với các vị trí khác ta sẽ có được các bước di chuyển của 
Clip video theo ý muốn. 

- Nhấn nút Play  trên cửa sổ monitor hoặc kéo thanh trượt thời gian trên cửa 
sổ timeline  để xem. 

 

5.2. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

Nắm được các thao tác cơ bản để thực hiện việc tạo chuyển động cho Clip. 

 
Câu hỏi ôn tập 

- Liên hệ thực tế sau đó thực hiện lần lượt các hiệu ứng chuyển động của Clip 
trong thẻ Attribute. 

- Theo bạn, chúng ta có thể sử dụng chức năng chuyển động để thực hiện việc 
chuyển cảnh không ? Nếu được hãy thực hiện bài thực hành ở bài 4 bằng thao tác 
chuyển động cho Clip. 
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BÀI 6 

 KỸ XẢO 

Mục tiêu: 

- Áp dụng kỹ xảo cho Clip. 

- Hiệu chỉnh các kỹ xảo như mong muốn. 

- Tìm hiểu các hiệu ứng có sẵn của chương trình. 

 

Thời gian thực hiện 

 5 tiết hoàn thành, kể cả thời gian thực tập. 
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6.1. Áp dụng kỹ xảo video 

- Đặt Clip Video trên cửa sổ Timeline và click chọn nó 
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 - Vào Gallery chọn Video Filter: 

 + Kéo mở rộng Video Filter tìm 
đến hiệu ứng muốn sử dụng sao 
đó thả vào Clip video đã chọn. 

  + Khi Clip đã có hiệu ứng ta 
sẽ thấy biểu tượng trên Clip như 
hình 26. 
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6.2. Hiệu chỉnh kỹ xảo 

- Tại của sổ Option Panel click chọn nút Customize Filter thì một cửa sổ điều 
chỉnh các thông số của  kỹ xảo sẽ hiện ra. Ta điều chỉnh các thông số này sao cho 
hợp lý nhất. 

- Lưu ý : các cửa sổ điều chỉnh này rất khác nhau tùy từng loại kỹ xảo mà ta sử 
dụng sao cho hợp lý nhất. Ví dụ ở hình 28 là cửa sổ của kỹ xảo Comic. 
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Ví dụ: cửa sổ thay đổi các thông số của hiệu ứng Bubble 
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- Lập lại hai bước trên ở các thời điểm khác nếu muốn. 

- Nhấn nút Play  trên cửa sổ monitor hoặc kéo thanh trượt thời gian trên cửa 
sổ Timeline để xem. 
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6.3. Các loại kỹ xảo video có trong Ulead Video Studio 9.0 

 

 Độ sáng tối      

 Tạo bọt xà phòng  

 Hiệu ứng than chì   

Thay đổi cặp màu   

  Hiệu ứng hoạt hình         

  Cắt ảnh 

  Chống hạt                        

  Nhiễu xạ ánh sáng   

 Khuếch tán ánh sáng 

 Làm mờ 

 Hiệu ứng màu viết         

  Hiệu ứng mây, bụi 

 Cân bằng màu    

 Thay đổi màu 

 Lóe sáng ống kính   

 Làm nổi hình 

 Di chuyển mờ     

 Hiệu chỉnh màu sắc                        
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 Nổi ô ca rô 

 Di chuyển và phóng lớn 

 Hiệu ứng ánh sáng   

 Hiệu ứng tia sét 

  Hiệu ứng gương   

    Màu kim loại 

Làm mờ ảnh theo khung                  

  Làm ảnh sắc nét 

 Hiệu ứng ngôi sao 

Hiệu ứng gợn sóng 

 Hiệu ứng kính vạn hoa                   

 Lấy âm bản 

 Màu sơn dầu 

 Hiệu ứng  phim cũ   

  Làm phình to ảnh       

Hiệu ứng mưa 

Bóp méo hình                                 

 Hiệu ứng gió    

 Hiệu ứng xoáy nước 

 Hiệu ứng nước chảy                       
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6.4. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Áp dụng kỹ xảo cho các đoạn Clip. 

- Hiệu chỉnh các thông số cho kỹ xảo. 

- Tìm hiểu các khả năng của những kỹ xảo có sẵn của chương trình. 

 

Câu hỏi ôn tập 

- Trình bày các thao tác áp dụng kỹ xảo cho một Clip. 

- Liên hệ thực tế, hãy chọn một ý tưởng và một kỹ xảo bất kỳ phù hợp để tạo 
một đoạn Clip theo ý tưởng của bạn. 
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BÀI 7: 

CÁCH TẠO CHỮ 

Mục tiêu: 

- Tạo chữ trên nền Video 

- Tạo các chuyển động cho chữ 

 

Thời gian thực hiện 

 5 tiết hoàn thành, kể cả thời gian thực tập. 
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7.1. Tạo chữ trên Video: 

- Vào cửa sổ Gallery chọn Title để đến cửa sổ tạo chữ. 

- Hay click chọn nút Title trên thanh Step Panel 
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- Khi đó ta sẽ thấy cửa sổ Title xuất hiện.  

- Trong cửa sổ Title sẽ xuất hiện những mục sau: 
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- Trên Monitor Window sẽ xuất hiện dòng chữ  lệnh bảo rằng Double Click vào 
màn hình monitor để nhập chữ. Ta có thể nhập bất cứ chữ gì tùy thích  hay ta cũng 
có thể kéo một số mẫu chữ có sẳn trong Gallery. 

- Ở đây ta sẽ nhập dòng chữ Ulead Video Studio 9.0 như hình sau: 
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- Lưu ý: Khi nhập chữ thì tốt nhất là trước đó ta nên có một đoạn phim trên 
Timeline vì nền của monitor là màu đen mặc định nên khi nhập chữ sẽ không thấy 
khi màu của chữ cũng là màu đen. Còn nếu không thì ta sẽ chuyển màu chữ thành 
một màu khác để dễ dàng nhận thấy trong khi thao tác, Việc chuyển màu chữ ta sẽ 
nói ở phần ngay sau đây. 
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- Duration: thời gian xuất hiện của title. 

- Font : chọn Font chữ. 

- Font Size : kích cỡ của chữ. 

-  Color: thay đổi màu chữ. 

- Multiple titles: cho phép nhập nhiều Title cùng một lúc và cho di chuyển  từng title 
theo ý. 

- Single title : chỉ ưu tiên cho nhập một title và không cho di chuyển. 

- Vertical text: nhập chữ theo chiều dọc. 

- Border/Shadow: viền và bóng đỗ dùng để biên tập đoạn chữ theo ý thích. 

- Text backdrop: thanh nền cho chữ. 

- Alignment: chọn vị trí cho chữ.  

 

7.2. Tạo chuyển động cho chữ: 

Sau khi tạo chữ và hiệu chỉnh chữ thì việc quan trọng là tạo hiệu ứng và tạo 
chuyển động cho chữ. 

- Chọn chữ muốn tạo hiện ứng 

- Click chọn thẻ Animation 
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Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 40 
 
 

- Tiếp tục click chọn vào tùy chọn Apply animation. 

- Chọn kiểu hiệu ứng chữ chuyển động trong khung Type. Các mẫu chuyển 
động sẽ được hiển thị trong danh sách phía dưới, bạn chọn một kiểu theo chủ đề 
biên tập phim của bạn. 

-   Customize animation attributer: lựa chọn các thuộc tính cho các kiểu 
chữ chuyển động. Khi bạn click chọn thì một hộp thoại hiện thị với các thông số, 
tùy thuộc vào kiểu chuyển động mà thông số có thay đổi. 

- Ta có một số bảng Animation cho các hiệu ứng chữ chuyển động như sau: 
 

            

                       Drop 

                                                           
 

 

                      Fade 

 

 

                          Fly 

                            

                         Swing 
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                          Turn 

 

 

                         Zoom 

 

                        Pop-up 

Lưu ý: để gõ được tiếng Việt thì ta phải chọn font chữ VNI-….. như trong 
hình sau: 
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- Để tạo được các chuyển động ấn tượng và đẹp mắt thì các bạn phải thử chọn 
nhiều hiệu ứng chuyển động và thử thay đổi các thông số trong thẻ Animation. 
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7.3. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Cách tạo chữ trên nền Video. 

- Nắm được các thao tác và một số hiệu ứng chuyển động của chữ. 

 
Câu hỏi ôn tập 

- Khi tạo chữ, vì sao phải chọn Clip video trước ? 

- Thực hiện một đoạn video chữ sử dụng nhiều hiệu ứng khác nhau và bổ sung 
vào bảng liệt kê các chuyển động của chữ chức năng cụ thể của từng chuyển động. 
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BÀI 8: 

CAPTURE VÀ XUẤT PHIM 

Mục tiêu: 

- Thực hiện đưa Video từ băng từ (Tape) vào máy tính 

- Xuất Project hoàn chỉnh thành tập tin Video và ghi ra đĩa 

 

Thời gian thực hiện 

 5 tiết hoàn thành, kể cả thời gian thực tập. 
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8.1. Capture 

1- Capture nhanh bằng trình Wizard: 

- Khi khởi động chương trình bạn sẽ thấy hộp thoại (Bài 1):  

 

 

Hình  36 

 

- Để chuyển phim từ máy quay vào máy tính ta chọn nút DV-to-DVD Wizard. 
Khi đó hộp thoại Ulead VideoStudio  DV-to-DVD Wizard xuất hiện: 
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- Tên thiết bị máy quay sẽ hiển thị trong khung Device. (Chú ý việc hiển thị 
các thiết bị máy quay còn tùy thuộc vào việc cài đặt phần mềm điều khiển riêng của 
từng thiết bị tương thích với hệ điều hành bạn đang sử dụng). Nếu có nhiều thiết bị 
cắm vào máy tính bạn nhấp vào khung Device để chọn tên thiết bị chứa đoạn phim 
bạn cần đưa vào. 

- Chọn xong bạn Click vào nút Start Scan để bắt đầu đưa đoạn phim vào để xử 
lý. Tuy nhiên bạn có hai lựa chọn để bắt đầu đưa phim vào: 

+ From beginning: tùy chọn để bắt đầu đưa toàn bộ đoạn phim vào máy tính. 

 + From curent position: bắt đầu quét chuyển từ vị trí bạn chọn. 

 + Speed: tốc độ quét chuyển từ thiết bị vào máy tính.  
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- Khi bắt đầu thực hiện việc quét chuyển thì hộp thoại xuất hiện như sau: 
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- Khung bên phải hiển thị các cảnh quay mà bạn ngắt máy chuyển cảnh khi 
quay.  Mỗi khung ảnh là một cảnh quay. 

- Nếu không muốn thực hiện nữa thì bạn click chọn nút Stop scan. 

- Thực hiện xong bạn chọn cảnh phim cần xử lý và click nút Next để chuyển 
qua hộp thoại kế tiếp. 
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- Chọn kiểu mẫu phù hợp với chủ đề đoạn phim của bạn trong khung Theme 
template. 

- Chọn chất lượng trong khung Video Quality ( High: chất lượng cao; 
Standard: chất lượng chuẩn; Compact: chất lượng thấp) 

- Để đĩa DVD hay VCD vào ổ đĩa và bắt đầu thực hiện ghi bằng cách click 
vào nút Burn. 

  

2- Capture từ băng vào máy tính: 

- Để thực hiện việc này ta tiến hành các bước như sau: 

- Trên thanh Step Panel chọn Capture sau đó chọn Capture Video 
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- Hộp thoại Capture hiển thị với các thông số sau: 

 + Duration: định khoảng thời gian chiều dài chuyển từ băng vào máy tính  

 + Source: Tên thiết bị chứa đoạn phim bạn cần chuyển vào máy tính 

 + Format: chọn định dạng chuyển cần lưu. Các định dạng như: DV, AVI, 
MPEG, VCD, DVD…. 
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- Đánh dấu tùy chọn Split by Scence sẽ cắt những đoạn bạn ngắt máy chuyển 
cảnh thành những đoạn riêng biệt 

- Capture folder: lựa chọn nơi lưu trữ đoạn phim chuyển vào máy tính. 
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- Thực hiện xong bạn click vào nút Start Caprure để thực hiện chuyển đổi, 
muốn dừng lại thì click vào nút Stop Capture. 
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- Khi chuyển xong, đoạn phim bạn vừa chuyển sẽ được đưa vào thư viện Video. 

 

3- Chuyển phim từ DVD vào máy tính thông qua lớp Capture: 

- Để thực hiện việc này ta tiến hành các bước như sau: 

- Trên thanh Step Panel chọn Capture  

- Chọn Import from DVD /DVD-VR 
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- Khi đó hộp thoại Browse for Folder sẽ xuất hiện 
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- Ta chọn tên ổ đĩa DVD chứa đoạn phim cần chuyển và nhấn nút OK. 

- Lúc đó hộp thoại Import DVD sẽ xuất hiện. 
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- Ta đánh dấu chọn các Chapter (một Chapter sẽ tương ứng với một đoạn) cần 
đưa vào xử lý ( các Chapter được chọn sẽ được đánh dấu . Chọn xong ta nhấn 
vào nút Import để thực hiện, nhấn nút Stop Import để dừng. 

- Khi chuyển xong, đoạn phim bạn vừa chuyển sẽ được đưa vào thư viện Video. 

 

8.2. Xuất phim 

1- Xuất thành file Video: 

- Khi đã biên tập xong, việc còn lại của chúng ta là xuất ra thành tập tin để 
trình chiếu trên máy tính hoạc trên các đầu DVD- VCD thông dụng. 

 - Trên thanh Step Panel click chọn Share 

 - Hộp thoại lớp Share xuất hiện 
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- Click chọn Create Video File. Danh sách các định dạng Video hiển thị 
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- Ta chọn một định dạng cần xuất trong danh sách (trong ví dụ chọn PAL 
MPEG2 - 720x576, 25fps) 

- Hộp thoại Creater Video File hiển thị, bạn đặt tên trong khung File name 
(nhớ chọn tên ổ đĩa và thư mục chứa tập tin cần xuất) sau đó nhấn nút Save. 

- Chương trình sẽ bắt đấu thực hiện việc biên dịch, sau khi biên dịch xong bạn 
có thể xem tập tin phim bằng các trình xem phim thông dụng như Window Media 
Player, HeroSoft………. 

 

2- Xuất ra đĩa DVD-VCD: 

- Nếu bạn có ổ đĩa ghi DVD hay VCD thì việc xuất những đoạn video mà ta 
biên tập xong ra đĩa là rất đơn giản. Ta thực hiện các bước như sau: 

- Trên thanh Step Panel click chọn Share 

- Hộp thoại lớp Share xuất hiện 
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- Click chọn Create Disc. Hộp thoại Ulead Video Studio Create Disc xuất hiện: 
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+ Output disc Format: chọn định dạng đĩa (DVD, VCD, SVCD) 

+ Add Vieo: có thể chèn thêm đoạn phim vào danh sách 

+ Add Videostudio Project: chèn thêm phim dự án vào danh sách. 

+ Import DVD/DVD-VR: chèn thêm các đoạn phim từ DVD vào danh sách. 

+ Create Menu: cho phép tạo menu cho đĩa. 
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- Khi thực hiện bạn nhớ xem mức báo dung lượng còn trống mà định dạng đĩa 
bạn chọ để có thể loại bỏ hoặc thêm các đoạn phim sao cho thích hợp nhất. 
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- Khoảng màu xanh trên thanh dung lượng báo mức dung lượng phim hiện có 
trên định dạng đĩa bạn chọn. 

- Lựa chọn xong bạn nhấn nút Next để tiếp tục 

- Đến đây thì ta chỉ cần đưa đĩa trắng vào ổ đĩa và thao tác trên hôp thoại 
Ulead VideoStudio Create Disc. 
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Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 55 
 
 

- Disc volume label: đặt tên cho đĩa. 

- Drive: Lựa chọn ổ ghi chứa đĩa trắng (nếu bạn có nhiều ổ ghi) 

- Burning speed: chọn tốc độ ghi (thông thường để đọc trên các đầu VCD-
DVD ta nên chọn tốc độ ghi thấp, ví dụ như 8x chẳng hạn) 

- Copies: số lượng đĩa cần ghi. 

- Nếu sử dụng đĩa ghi lại nhiều lần, ta nên chọn mục  để định 

dạng lại đĩa trước khi ghi. 

- Cuối cùng bạn chọn nút  để thực hiện việc ghi. 

 

8.3. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Thực hiện capture video từ băng, trích xuất tập tin video từ DVD 

- Thực hiện chức năng Capture.Wizart 

- Thực hiện việc xuất phim thành nhiều định dạng (tập tin video, CD, DVD,…) 

 

Câu hỏi ôn tập 

Trong điều kiện thực tế của bạn (thiết bị phần cứng), bạn có thể thực hiện bài 
học này đến mức độ nào ? 
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PHẦN 2: 

PHẦN MỀM  

ADOBE PREMIERE PRO 1.5 

 

NỘI DUNG THỜI LƯỢNG 

Bài 1 : Giới thiệu 2 tiết 

Bài 2 : Làm việc với Project 3 tiết 

Bài 3 : Biên tập Video 10 tiết 

Bài 4 : Chuyển cảnh 5 tiết 

Bài 5 : Tạo chuyển động 5 tiết 

Bài 6 : Kỷ xảo 5 tiết 

Bài 7 : Chồng hình ảnh 5 tiết 

Bài 8 : Cách tạo chữ 5 tiết 

Bài 9 : Capture và xuất phim 5 tiết 

Tổng số 55 tiết 
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BÀI 1 

GIỚI THIỆU 

 
 
 

Mục tiêu: 

Giúp học viên có cái nhìn khái quát chương trình biên tập và dựng 
video Adobe Premiere Pro 1.5.  

Cách khởi động chương trình Adobe Premiere Pro 1.5 

Tìm hiểu về giao diện chương trình.  

Tìm hiểu các chức năng, nhiệm vụ chính của từng phần giao diện. 

 

Thời gian thực hiện 

  2 tiết hoàn thành, kể cả thời gian thực tập. 
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1.1. Giới thiệu chung 

Adobe Premiere Pro 1.5 là một chương trình xử lý phim ảnh chuyên nghiệp. Đây là 
một chương trình rất mạnh về biên tập Video, hầu như có đủ mọi công cụ cần thiết cho 
những nguời làm phim có thể thực hiện các ý tưởng của mình. 

Adobe Premiere Pro 1.5 là công cụ kỹ thuật cao, tạo ra hình ảnh và âm thanh 
theo cách nhìn mới, mang tính chuyên nghiệp hơn, thực hiện nhiều đề án ngắn và 
dài theo tiêu chuẩn chính xác. 

Adobe Premiere Pro 1.5 cho phép dựng nhiều kết quả chính xác trong mỗi lần 
dựng; tạo ra nhiều đề án hợp lý trong việc sử dụng màn hình giao diện đẹp mắt, môi 
trường làm việc tiện lợi và quen thuộc; điều chỉnh màu sắc một cách dễ dàng; biên tập 
chính xác; làm việc thuận tiện với hình ảnh, video số và xuất thành phim. 

Phần mềm Premiere Pro 1.5 là một phần mềm khá phức tạp đòi hỏi phải có 
một kiến thức rất rộng, sâu về nhiều lĩnh vực khác nhau, đặt biệt là các kiến thức về 
điện ảnh và truyền hình. Muốn hiểu hết điều kỳ diệu của nó thì cần phải có một quá 
trình làm việc và tìm hiểu lâu dài. Tuy nhiên, tài liệu này sẽ cho chúng ta một cái 
nhìn tổng quát nhất, cơ bản nhất về Phần Mềm Dựng Phi Tuyến Adobe Premiere 
Pro 1.5 để từ đó chúng ta có thể hiểu được và tạo ra được những sản phẩm đẹp mắt 
theo mong muốn. 

 

1.2. Khởi động chương trình Premiere Pro 1.5 

 

 Nhấp đúp chuột vào biểu 
tượng Adobe Premiere Pro 1.5 
trên màn hình (hình 1) hoặc 
Chọn Start > Programs > Adobe 
Premiere Pro 1.5 (hình 2) 

 

  Hình  52 

 
Hình  53 
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Hộp thoại xuất hiện: 

Với Adobe Premiere Pro 1.5 để bắt đầu vào chương trình, ta phải chọn New 
Project để tạo một Project mới hoặc mở một Project đã có sẵn bằng cách click vào 
nút Open Project hoặc chọn tên một Project trong danh sách Recents Projects đang 
hiện bên trên (hình 3). 

 

 
Hình  54 

1.3. Giao diện 

Màn hình giao diện của Adobe Premiere Pro 1.5 gồm : 

 

 

Hình  55 
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1- Cửa sổ Project (Project Window) 

Là nơi lưu trữ tất cả các 
đoạn Clip Video, Audio, các file 
ảnh tĩnh được lấy ra bằng cách 
Import hoặc Capture từ băng hay 
Camera, có thể thêm hoặc bỏ các 
đoạn Clip mà ta đã đưa vào. 

Trong Project có chứa bảng 
Effects để thực hiện các kỹ xảo 
như kỹ xảo âm thanh và hình ảnh, 
chuyển cảnh. 
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2- Monitor Window:  

Cửa sổ này gồm hai màn hình: Trim và Program.  

Màn hình Trim để xem riêng một Clip và có thể đánh dấu các điểm cần thiết 
để cắt hình.  

Màn hình Program để xem trạng thái hiện tại của các Clip đang được dựng 
trên cửa sổ Timeline. 
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3- Timeline Window: 

Cho ta thấy tất cả các track Video, track Audio. Các thay đổi trên các track sẽ 
được hiển thị trên màn hình Program. 
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1 Track Video;  

2 Track Audio;  

3 Con trượt chỉ thời gian hiện hành;  

4 Thanh chỉ vùng làm việc;  

5 Thanh thời gian;  

6 Thanh chỉ vùng hiển thị;  

7 Zoom out;  

8 Con trượt zoom;  

9 Zoom in 
 

3 5 6

1 

7 

4 

2 

8 9 
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 4- Bảng Info: 

Trình bày thông tin về một Clip được 
chọn hoặc phép chuyển cảnh (hình 8). 

 

 

 5- History: 

Lưu trữ lại những thao tác đã thực hiện 
trước đó (hình 9) 
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6- Thanh công cụ 

Chứa một bộ công cụ để chọn lựa và dàn dựng các Clip trong dự án. Các công 
cụ tượng trưng bằng các biểu tượng nhỏ trong bảng công cụ nằm phía bên trái cửa 
sổ Program. 
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1- Select;  
2- Track Select;  
3- Ripple Edit;  
4- Rolling Edit;  
5- Rate Stretch;  

6- Razor;  
7- Slip;  
8- Slide;  
9- Pen  
10- Hand;  
11- Zoom. 

 

1 2 3 4 7 98 10

5 6

11
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1.4. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Cách khởi động chương trình Adobe Premiere Pro 1.5. 

 - Tìm hiểu chức năng hoạt động của các vùng, thanh làm việc của chương 
trình. 
 

Câu hỏi ôn tập 

Hãy so sánh sự giống nhau và khác nhau giữa giao diện của hai chương trình 
Adobe Premiere Pro 1.5 và Ulead Video Studio 9.0. 
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BÀI 2 

LÀM VIỆC VỚI PROJECT 

Mục tiêu 

Giúp học viên có cái nhìn khái quát về khái niệm Project của chương 
trình Adobe Premiere Pro 1.5.  

Tìm hiểu về các thao tác cơ bản như tạo, mở, sao lưu, … 

Thời gian thực hiện 

 3 tiết hoàn thành, kể cả thời gian thực tập. 
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2.1. Khái niệm 

Project là một dự án làm phim trong Premiere, lưu trữ tất cả các đoạn Clip 
khác nhau và chứa đựng những thông tin về cách sắp xếp chúng. Trong một file của 
Project, ta có thể kết hợp nhiều cảnh riêng lẻ thành một chương trình hoàn chỉnh 
bằng cách chuyển cảnh, thực hiện kỹ xảo, các phép chồng hình, ghép hình hoặc trộn 
âm thanh… 

 

2.2. Tạo Project mới: 

Thực hiện một trong các cách sau: 

- Nếu chưa khởi động Premiere thì khởi động Premiere. 

- Nếu Premiere đã khởi động nhưng chứa có project nào mở thì click vào nút 
Open Project. 

- Nếu có một Project đang mở thì chọn File > New > Preject. 

Khi hộp thoại New Project xuất hiện thì thực hiện một trong những cách sau: 

- Để áp dụng một thiết lập có sẵn thì chọn 
nó trong danh sách Available Presets. ở tab 
Load Preset (hình 11).  

- Để tự thiết lập thì chọn thẻ Custom 
setting sau đó thiết lập các thông số (Hình 12): 
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- Editing Mode: chọn chế độ biên tập Video:  

+ DV playback: Biên tập Video chuẩn băng số. Kích thước khung 
hình mặc định: 720x480 (NTSC) và 720x576 (PAL). 

+ Video for Window: biên tập Video theo chế độ chuẩn của 
Window. Kích thước mặc định: 320x240 (NTSC) và 352x288 (PAL). 
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- Timebase: Chọn số frames/giây. 

- Frame size: kích thước khung hình:  

 + 720 x 480 (NTSC chuẩn DV) 

 + 720 x 576 (PAL chuẩn DV) 

 + 320 x 240 (NTSC)  

 + 352 x 288 (PAL) 
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- Pixel Aspect Ratio: tỉ lệ điểm ảnh  

- Sample Rate: tốc độ mẫu (hay tần số lấy mẫu) cho Audio. 

- Nút Save Preset: lưu các thiết lập. 

- Location: vị trí lưu trữ Project. 

- Name: Tên Project với phần mở rộng mặc định là .prproj (hình 13).  
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2.3. Lưu một Project. 

Để lưu một Project: 

- Vào Menu File > Save để lưu Project đang mở. 

- Để lưu sao chép (lưu với tên khác) một dự án và tiếp tục làm việc trong bản 
sao chép mới thì chọn File > Save as, rồi chọn nơi muốn lưu và đặt tên cho tập tin, 
sau đó click vào nút Save. 

- Để lưu sao chép dự án nhưng tiếp tục làm việc trong dự án nguồn thì chọn 
File > Save a copy, rồi chọn vị trí và tên tập tin, sao đó chọn nút Save 
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2.4. Mở một Project 

 

Nếu vừa khởi động 
Adobe Premiere Pro thì click 
vàp nút Open Project hoặc 
vào danh sách đang liệt kê các 
project (hình 54). 

Nếu đã khởi động Project 
và muốn mở một Project khác 
thì chọn File > Open Project. 
Tìm đến nơi chứa Project và 
chọn Project muốn mở rồi 
Click Open. Hình  66 
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2.5. Nhập Clip vào Project 

Để đưa các Clip đã lưu trên ổ đĩa vào Project ta thực hiện một trong những 
cách sau: 

- Vào menu File chọn Import. 

- Double click vào vùng trống trên cửa sổ Project. 

- Click vào nút New Item  dưới cửa sổ Project (hình 67) 

Hình  67 

- Cửa sổ Import xuất hiện. Chọn nơi lưu trữ các Clip để mở. 
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+ Nếu muốn chọn nhiều Clip liên tiếp thì nhấn phím Shift trong khi 
chọn 

+ Nếu muốn chọn nhiều Clip không liên tiếp thì nhấn phím Ctrl trong khi chọn. 

+ Nếu muốn Import một Folder thì chọn Folder rồi chọn Import Folder. 

+ Nhấn nút Open để Import 
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2.6. Sắp xếp các Clip trên Timeline 

Để sắp xếp các Clip lên Timeline ta thực hiện như sau: 

- Chọn một hoặc nhiều Clip trên cửa sổ Project 

- Kéo các Clip đã chọn thả các track Video hoặc Audio tương ứng trên cửa sổ 
Timeline. 

 

 

Hình  69 

 

2.7. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Tìm hiểu về khái niệm Project (dự án) 

- Thực hiện các thao tác cơ bản với Project như : New Project, Save, 
Open Project, Import, … 

 

Câu hỏi ôn tập 

- Trình bày khái niệm về Project (dự án). Các chuẩn Video của chương trình 
Adobe Premiere Pro 1.5 có khác gì so với chương trình Ulead Video Studio 9.0. Tìm 
hiểu thêm và suy ra nhận xét về các chuẩn Video (nếu có thể). 

- Tập tin project sẽ có phần mở rộng là gì ? 

- Khi thực hiện lệnh nhập Clip vào project ta có thể chọn tập tin project được 
không ?  
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Bài tập 

1. Khởi động chương trình Premiere 

2. Tạo một dự án (Project) mới với tên baimodau.prproj 

3. Import một Clip (Clip A)  vào dự án 

4. Đặt Clip vào track Video 1 của cửa sổ Timeline 

5. Lưu dự án đã tạo. 

6. Lưu dự án với tên mới là  myProject1.prproj 

7. Import thêm 2 Clip (Clip B và Clip C) vào dự án 

8. Đặt hai Clip này lên hai track Video 1 và Video 2 chồng lên nhau ngay sau Clip 
A.  
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9. Lưu dự án myProject1.prproj 

10. Mở lại dự án Baimodau.prproj 
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BÀI 3 

BIÊN TẬP VIDEO 

 
 

Mục tiêu: 

Giúp cho học viên nắm được các thao tác cơ bản về công tác 
biên tập video trên máy tính như: đánh dấu những điểm quan trọng 
trên Clip, cắt Clip, thay đổi thời lượng của một Clip, biên tập các 
điểm vào ra trên Clip, xóa hoặc di chuyển các Clip trên Timeline, 
thêm hoặc bớt các track trên Timeline. 

 

Mục tiêu 

5 tiết hoàn thành, kể cả thời gian ôn luyện và thực tập 
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3.1. Vạch dấu 

Vạch dấu là đánh dấu các vị trí để giúp cho việc xác định những điểm quan 
trọng theo thời gian, qua đó biết được cách sắp xếp của các Clip.  

Trên cửa sổ Timeline và trên mỗi Clip có thể chứa từ 0 – 9 vạch dấu có đánh 
số thứ tự, ngoài ra còn có thể chứa đến 999 vạch dấu không đánh số. 

 

1- Thêm vạch dấu: 

Thực hiện một trong các bước sau: 

- Đánh dấu không số trong cửa sổ Timeline. 

+ Di chuyển thanh trượt đến vị trí cần đánh dấu. 

  + Vào Menu Marker > Set Sequence Marker > Unnumbered. 

 - Đánh dấu bằng số trong cửa sổ Timeline 

  + Di chuyển thanh trượt đến điểm cần đánh dấu. 

  + Chọn Menu Marker > Set Sequence Marker  > 
Other Numbered. 

  + Nhập số và OK. 
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 - Đánh dấu không số trên Clip 

  + Di chuyển thanh trượt đến vị trí cần đánh dấu. 

  + Vào Menu Marker > Set Clip Marker > 
Unnumbered. 

Hình  72 

- Đánh dấu bằng số trên Clip 

+ Di chuyển thanh trượt đến điểm cần đánh dấu. 

+ Chọn Menu Marker > Set Clip Marker > Other Numbered. 

+ Nhập số và OK. 
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2- Di chuyển tới một vạch dấu 

- Kích hoạt cửa sổ Timeline hoặc Clip. 

- Thực hiện một trong các bước sau: 

+ Để chuyển tới một dấu đã đánh số trên Timeline, chọn Marker > Go 
to Sequence Marker > Numbered hoặc nhấn Ctrl + 3. Khi cửa sổ Go to 
Numbered Marker hiện ra, chỉ cần chọn số muốn tìm, rồi nhấn OK. 

+ Trên cửa sổ Timeline, chọn điểm Marker đang hiển thị, sau đó vào 
Menu Marker > Go to Sequence Marker > Next (Ctrl + Right)/ Previous 
(Ctrl + Left) để nhảy tới hoặc nhảy lùi lại điểm đánh dấu so với dấu hiện tại. 

+ Để chuyển tới một dấu đã đánh số trên Clip, chọn Marker > Go to 
Clip Marker > Numbered hoặc nhấn Ctrl + Shift + 3. Khi cửa sổ Go to 
Numbered Marker hiện ra, chỉ cần chọn số muốn tìm, rồi nhấn OK. 

+ Để chuyển tới một dấu không số trên Clip, chọn điểm Marker đang 
hiển thị, sau đó vào Menu Marker > Go to Clip Marker > Next (Ctrl + 
Shift + Right)/ Previous (Ctrl + Shift + Left) để nhảy tới hoặc nhảy lùi lại 
điểm đánh dấu so với dấu hiện tại. 

  

3- Xoá tất cả các điểm vạch dấu 

- Chọn cửa sổ Timeline hoặc đoạn Clip muốn xóa vạch dấu. 

- Vào Marker > Clear Sequence Marker > All Markers (Alt + 0) hoặc 
Marker > Clear Clip Marker > All Markers (Alt + Shift + 0).  

   

4- Xoá một vạch dấu 

- Di chuyển thanh trượt đến điểm cần xoá. 

- Vào Menu Marker > Clear Sequence Marker > Current Marker (Ctrl+0) 
hoặc Marker > Clear Clip Marker > Current Marker (Ctrl + Shift + 0) 
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3.2. Biên tập điểm In – Out 

- Trên cửa sổ Timeline. 

+ Di chuyển thanh trượt đến điểm cần đánh dấu. 

+ Vào Menu Marker > Set Sequence Marker > In/ Out. 

- Trên cửa sổ Monitor . 

+ Drag hình ảnh từ Project vào cửa sổ Monitor. 

+ Đưa thanh trượt đến vị trí cần đánh dấu. 

+ Đánh Marker In . 

+ Sau đó chọn điểm tiếp theo và đánh Marker Out . 

Để xoá Marker In/ Out, vào Marker > Clear Clip Marker > In and Out 
hoặc nhấn G trên bàn phím. 

 

3.3. Thêm hoặc bớt Track 

1- Thêm Track 

- Vào Sequence > Add tracks > Add Video / Add Audio. 

- Nhập số liệu, sau đó click OK. 

2- Xoá Track 

Vào Sequence > Delete Tracks > Delete Video / Audio. Sau đó click OK. 

3- Đặt tên track: 

Click phải chuột vào tên track, chọn Rename. 

Đặt tên cho track, click OK. 

4- Di chuyển trong Timeline 

Di chuyển thanh trượt theo ý muốn. 

Hoặc dùng công cụ bàn tay  (Hand tool) để di chuyển. 

5- Di chuyển vùng làm việc 

Dùng công cụ Hand  để kéo vùng nhìn qua trái hoặc qua phải. 

Dùng cây thước nằm trong cửa sổ Timeline để kéo qua trái hoặc phải. 
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3.4. Thay đổi thời lượng và tốc độ của Clip 

1- Chỉnh độ dài 

- Chọn Clip trên cửa sổ Timeline hoặc cửa sổ Project. 

- Thực hiện các bước sau: 

+ Vào Clip > Speed/Duration, nhấp vào nút link  để bỏ liên kết giữa 
Speed và Duration rồi nhập giá trị, sau đó nhấn OK. 

+ Dùng công cụ Select  đặt vào cạnh của Clip khi con trỏ biến thành 
hình  hoặc  di chuyển qua trái hoặc phải. 

 

2- Chỉnh tốc độ 

- Chọn Clip. 

- Để thay đổi tốc độ Menu Clip > Speed/ Duration.Trong hộp thoại, nhập giá 
trị phần trăm hoặc nhập Duration. Chọn Reverse Speed hoặc Maintain Audio Pitch. 
Click OK. 

- Hoặc dùng công cụ Rate Stretch  để di chuyển qua trái hoặc phải trong 
Timeline. 

 

3- Dừng hình lại 

- Chọn Clip. 

- Để chọn frame dừng hình ngoài các điểm In và Out. Mở Clip trong cửa sổ 
Source đặt con trỏ thời gian frame muốn dừng hình. 

- Vào Marker>Set Clip Marker > Other Numbered, khi cửa sổ Set Numbered 
Marker xuất hiện, đánh số 0, sau đó click OK. 

- Vào Clip > Video Option > Frame Hold, cửa sổ Frame Hold Options xuất 
hiện, click vào ô vuông kế bên Hold on, rồi chọn Marker 0. 

- Sau đó nhấn OK. 
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3.5. Chọn một Clip hoặc nhiều Clip 

- Chọn một Clip, ta dùng công cụ selection  click vào cửa sổ Timeline. 

- Để chỉ chọn phần Video hoặc Audio thôi, dùng công cụ selection  và nhấn 
Alt + click vào phần đó của Clip. 

- Để chọn nhiều Clip, dùng công cụ selection   và nhấn Shift + click vào 
đoạn Clip muốn chọn. 

- Để chọn một vùng các Clip, di chuyển con trỏ kéo thành hình chữ nhật từ 
bên ngoài dưới thanh thước thời gian vào các Clip muốn chọn. 

- Để thêm hoặc bớt một vùng các Clip trong vùng hiện hành bằng cách nhấn 
Shift + Drag con trỏ thành hình chữ nhật quanh các Clip muốn thêm hoặc muốn bớt. 
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- Để chọn tất cả các Clip tồn tại và sau một thời điểm nào đó  trên track, chọn 
công cụ    và click vào Clip đầu muốn chọn. Nhấn Shift + Click để chọn tất các 
Clip trên tất cả các Track từ thời điểm đó. 

- Để chọn các Clip trên một track mà không phụ thuộc vào mối liên kết Video 
và Audio của nó thì sử dụng công cụ  , nhấn Alt + click. 
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3.6. Cắt hình 

1- Sử dụng cửa sổ Timeline. 

- Nếu muốn cắt một hoặc nhiều Clip chồng nhau  thành nhiều phần nhỏ, hãy 
thực hiện một trong các bước sau trên cửa sổ Timeline: 

+ Đặt con trỏ thời gian vào vị trí muốn cắt, chọn Sequence > Razor at 
Current Time Indicator hoặc nhấn Ctrl + K trên bàn phím (không có bất kỳ 
Clip muốn cắt nào đang bị khoá). 

+ Dùng công cụ Razor  click vào vị trí muốn cắt. 

- Nếu muốn cắt bỏ phần đầu hoặc phần cuối thì sử dụng công cụ Select đặt 
vào đầu hoặc cuối của Clip khi con trỏ chuột biến thành hình  hoặc  thì Drag 
chuột để thay đổi 

- Để tiến hành chèn (Insert) hoặc ghép lấp hình (Overlay). 
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- Để lấp hình nhưng không đẩy các hình khác đi, kéo một hoặc nhiều Clip tới 
vị trí mới thả nút chuột. 

- Để chèn hình nhưng không đẩy các hình khác đi, kéo một hoặc nhiều Clip tới 
vị trí mới, nhấn phím Ctrl khi thả chuột. 

- Để lấp hình đồng thời đẩy các hình khác đi, nhấn Ctrl và kéo một hoặc nhiều 
Clip tới vị trí mới, thả phím Ctrl  trước khi thả chuột. 

- Để chèn hình nhưng không đẩy các hình khác đi, nhấn Ctrl và kéo một hoặc 
nhiều Clip tới vị trí mới, giữ phím Ctrl khi thả chuột. 
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2- Sử dụng vùng nhìn Source trong cửa sổ Monitor 

- Kéo Clip từ cửa sổ Project thả 
vào cửa sổ Monitor. 

- Chọn frame muốn cắt, nhấp vào 
nút In point   - đánh dấu điểm đầu 
hoặc nhấp nút Out Point  - đánh dấu 
điểm cuối. 

- Xác định vị trí con trỏ trên 
Timeline. Rồi thực hiện 

- Nếu muốn chèn hình thì click 
nút Insert  

- Nếu muốn chồng lấp hình thì 
click nút Ovelay  
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3.7. Copy và Paste 

1- Để sao chép một hoặc nhiều Clip: 

- Chọn một Clip hay nhiều Clip liên tiếp, rồi chọn vào Edit > Copy. 

- Trong cửa sổ Timeline chọn nơi đặt con trỏ mà ta muốn Copy hoặc Paste 
Clip đó. 

- Chọn một Track nào đó để Paste. 

- Thực hiện một trong các bước sau: 

+ Nếu muốn Paste theo kiểu chồng hình thì chọn Edit > Paste. 

+ Nếu muốn Paste theo kiểu chèn hình thì chọn Edit > Paste Insert. 

 

2- Để sao chép thuộc tính của một Clip tới Clip khác: 

- Chọn Clip cần sao chép. 

- Chọn một hoặc nhiều Clip trong cửa sổ Timeline: 

- Chọn Edit > Paste Attributes. 
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3.8. Dựng chương trình  

1- Ráp nối các Clip tự động 

- Sắp xếp các Clip trong Bin hoặc Project. 

- Nếu muốn sử dụng một số Clip, chọn chúng  menu   Automatic to 
Timeline. 

2- Tạo storyboard 

- File > New > Storyboard 

- Nhập File bằng cách. 

- Kéo từ Project vào Storyboard 

- Nếu chỉ muốn chọn một số Clip nào đó thì thi Bấm Ctrl + Click chuột vào 
các Clip. Nếu cần có thể sử dụng cửa sổ Monitor Source để đánh dấu các điểm 
In và Out. 

- Chọn File > Save As > Định vị trí đặt tên File. 

- Click Automate to Timeline 

- Chọn các Option 

 

3.9. Hiệu chỉnh Clip giữa các Clip 

1- Thực hiện cuộn 

- Chọn công cụ Rolling Edit     

- Đặt con trỏ vào đầu hoặc cuối của Clip, con trỏ chuột sẽ có dạng . Di 
chuyển con trỏ sang trái hoặc phải trên cạnh Clip sẽ thêm số Frame vào Clip này và 
đồng thời cắt đi số Frame của Clip kế bên. 
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Hình  77 

 
Hình  78 

 

2- Thực hiện sự gợn sóng 

 
Hình  79 

 Chọn công cụ Ripple 
Edit  . Di chuyển trỏ 
chuột đến điểm In/Out của 
đoạn Clip mà ta muốn thay 
đổi chổ đến khi con trỏ 
xuất hiện biểu tượng  
hoặc , sau đó di chuyển 
con trỏ qua trái hoặc phải, 
đoạn Clip mà ta muốn biên 
tập sẽ được dịch chuyển bù 
trừ nhưng thời gian vẫn 
không đổi. 

 
Hình  80 

 

3- Slip Tool 

- Dịch chuyển các frame hình đầu hoặc cuối vế phía trước hoặc ra sau mà 
không làm thay đổi bất cứ cái gì khác. Thời gian của chương trình và thời gian của 
các Clip không thay đổi. 
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- Chọn công cụ Slip 
, đặt con trỏ trên Clip và 

Drag sang trái nếu muốn bắt 
đầu và kết thúc sớm hơn; 
Drag sang phải nếu muốn 
bắt đầu và kết thúc trễ hơn.  
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4- Slide: trượt bên trên 

- Thời gian của chương trình không thay đổi 

- Chọn công cụ Side , 
Drag sang trái để cắt bớt các 
frame ở điểm Out của Clip 
trước và thêm vào các frame 
của Clip sau; Drag sang phải 
để cắt bớt các frame điểm In 
Clip phải và thêm vào các 
frame ở điểm out Clip trái 

 
Hình  82 

 

3.10. Xoá các thành phần trong khung cảnh 

1- Xoá bỏ khoảng trống giữa các Clip 

- Chọn khoảng trống, chọn Sequence > Ripple Delete 

- Hoặc click nút phải chuột chọn Ripple Delete 

 

2- Xoá bỏ một Clip hoặc một vùng các frame 

- Ta có thể xoá toàn bộ một Clip hoặc một vùng các frame từ cửa sổ Timeline 
bằng hai cách : 

- Xoá các frame từ chương trình và để lại một khoảng trống cùng thời lượng 
với các frame đã di chuyển. 
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- Việc các frame từ chương trình và lấp đầy chỗ trống đã xoá bằng cách dời 
các frame phía sau lên trước. 

- Các phương pháp này phần lớn có ích khi ta muốn xoá các frame ở giữa một 
Clip hoặc thông qua nhiều Clip trên cùng track.  

 

3- Để xoá các frame mà không ảnh hưởng các Clip khác: 

Thực hiện một trong các cách sau : 

- Để xoá toàn bộ một Clip, chọn một hoặc nhiều Clip trong khung cảnh rồi 
nhấn  Delete.  

- Để xoá một vùng các frame, sử dụng các điều khiển trong khung nhìn 
Program để điểm In và điểm Out, rồi click  nút lift . 

 

4- Để xoá các frame và xoá bỏ khoảng trống chỗ trống kết quả. 

Thực hiện một trong các cách sau : 

- Để xoá toàn bộ Clip, chọn một hoặc nhiều Clip, rồi chọn Edit > Ripple 
Delete.  

- Để xoá một vùng các frame, sử dụng điều khiển trong khung Program để xác 
định điểm In và Điểm Out, và kích nút Extract . 

 

5- Để xoá tất cả các Clip trên track : 

- Chọn công cụ track select .  

- Thực hiện một trong những cách sau  

- Để xoá cả âm thanh lẫn video của các Clip được liên kết, click vào Clip đầu 
tiên trên track. 

- Để chỉ xoá một Clip của Track và không có liên kết, Nhấn Alt click chọn các Clip. 

- Nhấn  Delete. 
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3.11. Di chuyển các Clip 

1- Chuyển động Clip trong Timeline 

- Nói chung, việc di chuyển một Clip đơn giản là kéo nó tới bất kỳ vùng nào 
trong một track thích hợp. Để làm cho việc sắp xếp các Clip thẳng hàng với nhau 
hoặc với một thời điểm được chỉ định trở nên dễ hơn, ta có thể kích hoạt đặc tính 
nhảy (Snap).  

- Khi di chuyển một Clip với các bước nhảy,  nó tự động sắp thẳng hàng với 
các bước nhảy, hoặc tới mép Clip khác, hoặc tới một điểm đánh dấu, hoặc tới  điểm 
bắt đầu và kết thúc của trục thời gian, hoặc tới con trỏ chỉ báo thời gian hiện tại. 

- Việc bật snap cũng giúp ta bảo đảm không thực hiện tình cờ biên tập chèn 
hoặc chồng Clip khi kéo. Khi kéo Clip, một đường thẳng đứng với mũi tên xuất 
hiện để báo cho biết các Clip đã được sắp thẳng hàng. 

 

2- Để di chuyển một Clip tới một điểm trước hoặc  sau trong Timeline : 

- Kéo Clip sang trái hoặc phải, và định vị Clip bằng cách quan sát hình chữ 
nhật mờ đại diện thời lượng của Clip.  

- Nhấn Alt kéo để di chuyển một Clip mà không di chuyển phần liên kết  
video hoặc audio nó. Đây là cách dịch chuyển video và audio ra tách khỏi sự đồng 
bộ. 

- Ghi chú : Adobe Premiere 6.5 hoặc các phiên bản trước không cho phép kéo 
một Clip với từng bộ phận của một track. Adobe Premiere Pro cho phép để kéo 
một Clip qua một Clip khác để chèn hoặc chồng các Clip. 

 

3- Để di chuyển một Clip tới một track khác: 

- Kéo Clip lên hoặc xuống vào track ta muốn. 

- Ghi chú :  Khi ta kéo lần đầu một Clip chứa video lẫn audio (Clip liên kết) 
trên Timeline,  thì video và audio cũng chuyển tới các track tương ứng. Chẳng hạn, 
nếu ta kéo một Clip vào Video 3, thì âm thanh của Clip cũng được đặt vào Audio 3. 
Tuy nhiên, nếu  cố gắng kéo Video tới Video 3 nhưng Audio 3 đang sử dụng kiểu 
kênh khác, thì Audio chuyển tới track thích hợp tiếp theo, hoặc nếu không có track 
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thích ứng nào tồn tại, một một mới được tạo ra. 

4- Để cho phép và vô hiệu hoá đặc tính snap: 

Tại góc trái trên của cửa sổ Timeline, click nút  (Toggle Snap button) để 
chọn nó. Kích nó để lần nữa huỷ chọn nó. 

 

5- Để đưa một cạnh hoặc điểm đánh dấu của một Clip tới cạnh một Clip khác, 
hoặc điểm đánh dấu, hoặc chỉ con trỏ thời gian hiện hành: 

- Chắc chắn rằng nút Snap  đang được nhấn chọn trong cửa sổ Timeline. 

- Kéo mép của một Clip tới gần mép của Clip khác hoặc một điểm đánh dấu 
hoặc chỉ con trỏ thời gian hiện hành. Một đường thẳng đứng xuất hiện khi các Clip 
được sắp thẳng hàng. 

- Ta có thể chuyển trạng thái của thuộc tính Snap bằng cách sử dụng phím tắt 
(S) trong trong lúc đang thực hiện thao tác biên tập, ví dụ như đang di chuyển hoặc 
đang cắt một Clip. 

 

3.12. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Thực hiện hầu hết các thao tác về biên tập video. Đến đây, bạn đã có thể tự 
dựng cho mình một đoạn video đơn giản. 

- Nắm bắt các khái niệm về vạch dấu 

- Thực hiện hiệu chỉnh các Clip. 

 
Câu hỏi ôn tập 

- Trình bày khái niệm về vạch dấu của chương trình. 

 

Bài tập 2 (cắt Clip) – Biên tập 

1- Khởi động chương trình Premiere 

2- Tạo một dự án (Project) mới với tên baitap2.prproj và các thông số như sau: 
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- Timebase : 25 fames/second 
- Frame Size : 720 x 576 
- Pixel Aspect Ratio : D1/DV 
PAL (1.067) 

- Sample Rate : 32000 Hz 

 

3- Import một Clip có tên Blue good take off  trong thư mục Clip vào dự án 

4- Đặt Clip Blue good take off.avi  vào track Video 1 trên cửa sổ Timeline. 

 

 

5- Bấm tổ hợp phím Ctrl – S để lưu dự án đã tạo. 

6- Lưu dự án với tên mới là  myProject1.prproj 

7- Di chuyển thanh trượt thời gian đến thời điểm 1 giây bằng cách nhập 100 vào ô 
hiển thị giá trị thời gian. 
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8- Sử dụng công cụ razor hoặc nhấn phím C, đưa con trỏ chuột vào vị trí thanh 
trượt thời gian, nhấp chuột để cắt Clip thành hai phần.  

 

 
 

9- Chọn công cụ Selection , nhấp chọn phấn đầu rồi nhấn Delete để xóa bỏ. 

10- Di chuyển thanh trượt thời gian đền vị trí 12 giây. 

11-  Dùng công cụ chọn (Selection), đưa con trỏ chuột đến ngay điểm cuối của Clip, 
Đến khi con trỏ chuột có dạng  thì nhấn giữ chuột kéo đến vị trí của thanh trượt 
thời gian. 

12- Như vậy Clip đã được cắt bỏ phần đầu và phấn cuối. 

13- Bấm Ctrl + S để lưu lại. 

14- Thoát khỏi Premiere. 

 

Bài tập 3 (thay dổi tốc độ của Clip) – Biên tập (tiếp theo) 

1- Khởi động Premiere. 

2- Mở baitap2.prproj 

3- Di chuyển thanh trượt  thời gian đến vị trí 3s :17 

4- Sử dụng công cụ Razor hoặc nhấn phím C, đưa con trỏ chuột vào vị trí thanh 
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trượt thời gian, nhấp chuột để cắt Clip thành hai phần. 

5- Nhấp phải chuột vào đoạn Clip thứ 2, chọn Speed/Duration. 

6- Trong hộp thoại Clip Speed / Duration nhập giá trị cho ô speed là 30% rồi 
nhắp nút OK 

7- Nhấn nút Play   (hoặc thanh Spacebar) để xem. 
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BÀI 4 

CHUYỂN CẢNH 

 
Mục tiêu: 

Giúp học viên nắm bắt thao tác chuyển cảnh cơ bản có sẵn 
trong Adobe Premiere Pro 1.5. 

Tìm hiểu các thông số chính trong quá trình tạo chuyển cảnh. 

Ứng dụng được chuyển cảnh vào trong quá trình làm phim. 
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4.1. Khái niệm. 

Đây là phần kỹ xảo giúp khắc phục những đoạn gây khó chịu khi chúng ta 
thực hiện việc cắt dán, để tạo ra những chuyển cảnh đẹp, gây cảm giác dễ chịu, 
hướng thú cho người xem. 

 

4.2. Các thao tác cơ bản. 

1- Các bước thực hiện chuyển cảnh. 

Chọn và kéo 2 Clip hình ảnh từ cửa sổ Project thả xuống cửa sổ Timeline, hình 
ảnh sẽ được đặt theo thứ tự trong cửa sổ Timeline. 

 

 
Hình  83 

 

 Vào menu chọn Effects, rồi 
Click chọn Video Transitions, click 
vào nhóm chuyển cảnh cần chèn. 

 Kéo và thả chuyển cảnh đã chọn 
xuống cửa sổ Timeline để đưa vào 
điểm tiếp nối giữa 2 Clip.  

Hình  84 

 

 
Hình  85 
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Nhấn thanh SpaceBar hoặc nút  để xem chuyển cảnh trên cửa sổ Monitor. 

 

2- Điều chỉnh chuyển cảnh. 

Click chọn đoạn chuyển cảnh 

 Vào Window chọn Effect Controls, 
xuất hiện cửa sổ Effect Controls, sau đó 
tiến hành thực hiện việc điều chỉnh chuyển 
cảnh trên cửa sổ này. 

 Một số lệnh cần sử dụng: 

- Duration: thời lượng của chuyển cảnh. 

- Show Actual Sources: xem hình ảnh thực 

- Border Width: độ rộng của đường viền 

- Border Color: màu của đường viền 

- Reverse: đảo ngược 

- Anti – aliasing Quality: làm mịn 
đường viền 

Hình  86 
 

Lưu ý: một số đoạn chuyển cảnh có thể 
sử dụng lệnh Custom để hiệu chỉnh theo sở 
thích của người dùng. 

- Rectangle: hình vuông 

- Oval: hình Oval 

- Diamond: hình kim cương  

Sau khi đã chỉnh sửa xong, nhấn OK để 
xem lại đoạn chuyển cảnh. 

Hình  87 
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3- Các chuyển cảnh được sử dụng trong Premiere Pro 1.5 

 

Nhóm 3D Motion: các chuyển cảnh 3D. Nhóm Dissolve : làm tan ra 

- Curtain: màn cửa 

- Doors : cửa ra vào 

- Flip over: lật ngược 

- Fold up: sự trở lại 

- Spin: sự xoay tròn 

- Spin away: đường xoay 

- Swing in: đưa vào 

- Swing out: đưa ra 

- Tumble away: đoạn đường lối 

- Additive Dissolve: thêm vào 

- Cross Dissolve: hình chữ thập 

- Dip to Black: nhỏ dần về trong 

- Random Invert: đảo 

 
 
 

Nhóm Iris : mở rộng khẩu độ Nhóm Map : dạng bản đồ 

- Iris Cross: chữ thập 

- Iris Diamond: hình dạng kim cương 

- Iris Points: mũi nhọn 

- Iris Round: hình tròn 

- Iris Shapes: hình dạng vuông / oval / 
kim cương 

- Iris Square: dạng hình chữ nhật 

- Iris Star: hình sao 

- Channel Map: từ kênh bản đồ 
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Nhóm Page: lật trang Nhóm Slide: đường trượt 

- Page Peel : lật trang hình tháp vuông 

- Center Peel: lật từ tâm ra ngoài 

- Page Peel: lật từ góc xuống 

- Page Tunm: đường chéo 

- Peel Back: lật ngược  

- Rool away : trượt qua trái 

- Band  Slide: trượt xen kẽ 

- Center Merge: hình vuông trượt vào giữa 

- Center Split: hình chữ thập từ  tâm 

- Multi spin: những hình vuông xoay tròn 

- Push : hình trượt 

- Slash  Slide: trượt chéo xen kẽ 

 
 

Nhóm Special Effect : một số hiệu ứng 
đặc biệt 

Nhóm Stretch: sự duỗi ra 

- Direet: nhảy trực tiếp 

- Image Mask: gắn mặt nạ 

- Texturize: lát gạch 

- Three-D: thay đổi màu chuyển cảnh 

- Stretch In: duỗi từ trong ra ngoài 

- Stretch Out: duỗi từ ngoài vào trong 

 
 

Nhóm Wipe: quét hình Nhóm Zoom: phóng to thu nhỏ 

- Band Wipe: chèn chéo 

- Barm Doors: chuyển kiểu mở cửa 

- Clock Wipe: đóng cảnh chèn 

- Insert: chèn 

- Cross Zoom: to ra dần 

- Zoom Boxer: nhiều hình được Zoom 

 
 



 
 
Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 93 
 
 

4.3. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Nắm được các thao tác thực hiện chuyển cảnh. 

- Nắm được các hiệu ứng chuyển cảnh 

 

Câu hỏi ôn tập 

- Trình bày các thao tác chuyển cảnh. 

- Để kiểm tra trước kết quả của hiệu ứng chuyển cảnh ta kiểm tra như thế nào ? 

- Liên hệ thực tế, hãy giải thích ý nghĩa của các lựa chọn trong lệnh Custom để 
tạo sự linh hoạt cho hiệu ứng chuyển cảnh 

 

Bài tập 4 (tạo chuyển cảnh) 

1- Khởi động chương trình Premiere 

2- Tạo một dự án (Project) mới với tên baitap4.prproj 

3- Import các Clip có tên Along to slide.avi, Long Right Turn.avi trong thư 
mục Clip vào dự án. 

4- Đặt liên tiếp 2 Clip trên vào track Video 1 trên cửa sổ Timeline. 

5- Vào menu Windows chọn Effects.  

6- Trong cửa sổ Effect chọn mở rộng mục Video Transition, tiếp tục mở rộng 
mục Dissolve. Kéo mục Cross Dissolve thả vào tiếp giáp giữa 2 Clip 

 

7- Vào menu Window chọn Effect Controls. 

8- Nhập thời gian của chuyển cảnh là 2 giây tại mục Duration 

9- Nhấn nút Play   (hoặc thanh Spacebar) để xem. 

10- Vào menu File chọn Save để lưu Project lại. 
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Bài tập 5 (tạo chuyển cảnh – tiếp theo) 

1- Khởi động chương trình Premiere 

2- Mở lại baitap4.prproj 

3- Import thêm Clip có tên Inside Steering.avi trong thư mục Clip vào dự án. 

4- Đặt Clip Inside Steering.avi vào track Video 1 trên cửa sổ Timeline ngay 
sau các Clip đã có. 

5- Vào menu Windows chọn Effects.  

6- Trong cửa sổ Effect chọn mở rộng mục Video Transition, tiếp tục mở rộng 
mục Slide. Kéo mục Multi-Spin thả vào tiếp giáp giữa 2 Clip. 

7- Vào menu Window chọn Effect Controls. 

8- Nhập thời gian của chuyển cảnh là 3 giây tại 
mục Duration 

 

9- Nhấn nút Play   (hoặc thanh Spacebar) để xem. 

10- Trong Border Width giá trị bằng 1 

11-  Nhấp vào ô màu của mục Border Color 
chọn màu với các giá trị: R = 102, G = 207, 
B = 209. 

12- Nhấn nút Play   (hoặc thanh Spacebar) để xem. 

13- Nhấn vào nút Custom  

14- Nhập Horizontal = 2 và Vertical = 2. 

15- Nhấn nút Play   (hoặc thanh Spacebar) để xem. 

16- Vào menu File chọn Save As đặt tên file là baitap5.prproj 
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BÀI 5  

TẠO CHUYỂN ĐỘNG 

 

Mục tiêu: 

Giúp học viên có thể tạo ra các hoạt cảnh mong muốn cho các 
Clip video hay các tiêu đề giới thiệu chương trình như di chuyển 
Clip, làm mờ, xoay, phóng to hay thu nhỏ Clip…  qua đó làm sinh 
động các đoạn video Clip. 
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5.1. Cách thực hiện 

- Click chọn hình ảnh trên cửa sổ Project, đưa xuống và đặt song song với một 
Clip đã có sẵn trong cửa sổ Timeline. 

- Click vào Clip được chọn làm chuyển động. 

- Sau đó vào Window > Effect Controls, cửa sổ Effect Controls xuất hiện. 
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- Nhấn chọn mục Motion: thay đổi vị trí Clip. 

-  : tắt hoặc mở hiệu ứng 

-  : đánh dấu 

- Nếu sử dụng Postion: dùng xác định toạ độ. 

- Nếu sử dụng Scale Width: hiệu chỉnh đường viền. 

- Nếu như chọn Uniform Scale: thay đổi cả chiều rộng và chiều cao. 

- Nếu không chọn Uniform Scale: thay đổi chiều rộng và chiều cao riêng biệt. 

- Nếu sử dụng Rotation: dùng để xoay. 

- Nếu sử dụng Anchor point: xác định điểm neo. 
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5.2. Các thao tác tạo chuyển động 

- Chuyển thanh trượt thời gian đến thời điểm bắt đầu chuyển động. 

- Thay đổi các giá trị ở các mục Position, Scale, Rotation, … 

- Click vào dấu  ở các mục tương ứng như Position, Scale, Rotation, … để tạo 
một điểm neo giữ các giá trị được thay đổi, các điểm này gọi là các keyframe. 

- Chuyển thanh trượt thời gian đến thời điểm kết thúc chuyển động. 

- Thay đổi các giá trị ở các mục Position, Scale, Rotation, …, lúc này các 
keyframe tự động xuất hiện. 
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- Lập lại hai bước trên ở các thời điểm khác nếu muốn  

- Nhấn nút Play  trên cửa sổ monitor hoặc kéo thanh trượt thời gian trên trên 
cửa sổ Effect Controls để xem 

 - Để di chuyển qua lại giữa các keyframe, nhấn vào biểu tương Go to 
Preview Keyframe  hoặc Go to Next Keyframe  

 - Để thêm một keyframe hoặc xóa một keyframe tại vị trí thanh trượt 
thời gian, nhấn nút Add/Remove Keyframe   
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5.3. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

Cách thực hiện cơ bản để tạo chuyển động cho Clip. 

 

Bài tập 6 Tạo chuyển động 

1- Khởi động chương trình Premiere 

2- Tạo một Project mới với tên baitap6.prproj 

3- Import hai Clip có tên Good Slide.avi và mini_color_Match.avi trong thư mục 
Clip vào dự án. 

4- Đặt Clip Good Slide.avi vào track 
Video 1 trên cửa sổ Timeline và 
mini_color_Match.avi vào track 
Video 2 ngay trên Clip Good 
Slide.avi. 

5- Vào menu Windows chọn Effects Control.  

6- Trong cửa sổ Effects Control chọn mở rộng mục Motion. 

7- Nhấn phím Home để con chạy chỉ thời gian hiện hành về vị trí đầu của Clip. 

8- Nhập giá trị 0 cho trục X và 0 cho 
trục Y trong mục position  

9- Nhập giá trị 0.0 cho mục Scale  
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10- Nhấp vào biểu tượng  trước 
Position và Scale để tạo các điểm 
neo giữ giá trị vừa tạo 

11- Nhập giá trị 100 vào đồng hồ chỉ 
thời gian để con chạy chỉ báo thời 
gian về vị trí 1 giây.    

12- Nhập giá trị 500 cho trục X và 450 
cho trục Y trong mục position 

13- Nhập giá trị 30% cho mục Scale 
 

14- Nhấn phím Home để con chạy chuyển về đầu Clip. 

15- Nhấn thanh Space Bar để xem. 

16- Vào menu File chọn Save để lưu Project lại. 

 

Bài tập 7 Tạo chuyển động 

1- Khởi động chương trình Premiere 

2- Mở  baitap6.prproj 

3- Chọn Save As lưu lại với tên Baitap7.Prproj. 

4- Nhấn phím F9 để mở cửa sổ Adobe Title Designer. 

5- Nhập vào dòng SẮC MÀU CUỘC SỐNG. Với 
Color R = 60, G = B = 220 

6- Chọn Strokes, Nhấp vào Add của Outer Strokes 
để tạo đường viền. Chọn màu trắng cho đường 
viền và Size  =  18 
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7- Lưu và đóng cửa sổ Adobe 
Title Designer để chuyển 
về Premiere. 

8- Đặt title vừa tạo vào track 
Video 3 ngay phía trên 2 
track đã có sẵn trước đó. 

9- Vào menu Windows chọn 
Effect Controls. 

 

10- Đặt con trỏ thời gian về vị trí 0 giây, tại Position nhập trục X = 720, trục Y = 0 
và giá trị Scale = 0. Nhấp vào biểu tượng đồng hồ  trước mục Position và 
Scale. 

11- Chuyền đến thời điểm 1 giây, nhập X = 360, Y = 288. Nhấp vào biểu tượng 
đồng hồ  trước Rotation. 

12- Chuyển đến thời điểm giây thứ 2, tại 
Rotation nhập 1 x 00. 

13- Chuyển đến thời điểm giây thứ 3, nhập Scale = 150. 

14- Chuyển đến thời điểm giây thứ 4, nhập Scale  = 100 và Nhấp vào biểu tượng 
đồng hồ  trước Opacity. 

15- Chuyển đến thời điểm giây thứ 5, nhập Opacicy = 0 hình ảnh sẽ mờ dần và biến 
mất. 

16- Nhấn phím Home để con chạy chuyển về đầu Clip. 

17- Nhấn thanh Space Bar để xem. 

18- Vào menu File chọn Save để lưu Project lại. 
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BÀI 6 

 KỸ XẢO 

 

Mục tiêu: 

Giúp học viên tìm hiểu các kỹ xảo có sẵn được cung cấp kèm 
theo của Adobe Premiere Pro 1.5. Tìm hiểu các thông số cơ bản và 
cách ứng dụng chúng vào project. 
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6.1. Áp dụng kỹ xảo video 

- Đặt Clip Video trên cửa sổ Timeline. 
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 - Vào menu Windows chọn Effect. trong cửa sổ 
Effects thực hiện: 

 - Mở rộng Video Effect tìm đến hiệu ứng muốn 
sử dụng bằng cách click vào dấu  trước Video Effect 
và các nhóm Effect.  
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 - Kéo hiệu ứng xuống Clip trong cửa sổ Timeline. 

 - Nếu có một hộp thoại nhắc thì chỉ việc Click 
OK. Clip trên Timeline xuất hiện một đường màu 
xanh, cho biết đã có hiệu ứng trong Clip. 
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6.2. Hiệu chỉnh kỹ xảo 

- Vào menu Window > Effect Controls. 

- Ở mục kỹ xảo nhấn chọn nút có hình  trước tên hiệu ứng.  

 - Thay đổi các thông số cần thiết 
(tùy theo mỗi hiệu ứng mà các thông 
số này khác nhau). Một số hiệu ứng có 
nút Setup , ta có thể click vào đó 
để mở cửa sổ thay đổi các thông số. 

Hình  94 
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Ví dụ: cửa sổ thay đổ các thông số của hiệu ứng Clip 
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6.3. Hiệu chỉnh kỹ xảo theo thời gian 

- Chuyển thanh trượt thời gian đến thời điểm bắt đầu áp dụng hiệu ứng. 

- Thay đổi các giá trị các thông số của hiệu ứng. 

- Click vào dấu  ở các mục tương ứng ở các thông số để tạo các keyframe. 

- Chuyển thanh trượt thời gian đến thời điểm muốn thay đổi hiệu ứng. 

- Thay đổi các giá trị các thông số của hiệu ứng. 
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Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 104 
 
 

- Lập lại hai bước trên ở các thời điểm khác nếu muốn  

- Nhấn nút Play  trên cửa sổ monitor hoặc kéo thanh trượt thời gian trên trên 
cửa sổ Effect Controls để xem 

 

6.4. Hiệu ứng video có trong Adobe Premiere 

1- Nhóm Adjust : điều chỉnh 

♦ Auto Color : tự động điều chỉnh màu. 

♦ Auto Contrast : tự động điều chỉnh độ tương phản. 

♦ Level : thay đổi mức độ sáng tối. 

♦ Color Balance : điều chỉnh cân bằng màu. 

♦ Posterize : giảm màu. 

♦ Channel Mixer : trộn các kênh màu. 

♦ Extract : trích chọn ra một phần hình ảnh đen trắng. 
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2- Nhóm Blur &  sharpen: làm mờ & làm rõ nét 

♦ Antialias : bớt tương phản, làm cho dịu đi. 

♦ Channel Blur : mờ theo kênh. 

♦ Camera Blur : mờ theo hiệu ứng Camera. 

♦ Directional : mờ theo hướng. 

♦ Fast Blur : mờ nhanh. 

♦ Gaussian Blur : mờ theo hàm Gaussian (hình chuông). 

♦ Radial Blur : mờ theo hướng tâm. 

♦ Gaussian Sharpen : rõ nét theo hàm Gaussian. 

♦ Sharpen: làm nét. 

♦ Sharpen Edges : làm rõ nét cạnh. 
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3- Nhóm Channel : kênh 

♦ Blend : hoà trộn hình. 

♦ Invert : đảo màu. 
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4- Nhóm Distort : làm méo 

♦ Corner Pin : làm méo bằng cánh điều chỉnh các góc. 

♦ Lens Distortion : bóp méo như nhìn qua thấu kính. 

♦ Mirror :  tạo hình đối xứng như soi gương. 

♦ Ripple : tạo sự gợn sóng lăn tăn. 

♦ Spherize : gương cầu. 

♦ Transform : biến đổi. 

♦ Twirt : vòng xoắn. 
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5- Nhóm Image Control : hiệu chỉnh hình ảnh 

♦ Black and White :  chuyển ảnh thành đen và trắng 

♦ Color Balance : cân bằng màu. 

♦ Color Corrector : màu hiệu chỉnh. 

♦ Tint : sắc điệu 
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6- Nhóm Perspective : hình phối cảnh 

♦ Drop Shadow : tạo bóng cho hình có kênh anpha. 

♦ Bevel Alpha : tạo đường viền có kênh anpha. 

♦ Edge thickness : độ dày của cạnh. 

♦ Light Angle : góc chiếu sáng. 

♦ Light Intend : cường độ sáng. 

♦ Bevel Edges : làm nổi cạnh của hình. 

♦ Basic 3D : phối cảnh 3D 

♦ Swivel : xoay theo chiều đứng. 

♦ Tilt : xoay theo chiều ngang. 

♦ Distance to Image: khoảng cách. 
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7- Nhóm Render : tia sáng 

♦ Lens flare : loé sáng trong ống kính. 

♦ Lightning : tạo tia chớp. 

- Start point : vị trí điểm đầu của tia sét. 

- End point : vị trí điểm cuối của tia sét. 

- Segment : số đoạn. 

- Amplitude : Biên độ. 

- Detail level : Mức độ chi tiết. 

- Detail amplitude :biên độ chi tiết. 

- Branching : số nhánh 

- Rebranching : tạo các nhánh phụ. 

- Stablity : độ ổn định. 

♦ Ramp : tạo sương mù. 
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8- Nhóm Stylize :  

♦ Alpha Glow : toả sáng quanh kênh alpha. 

 

 

 

- Glow : phạm vi toả sáng. 

- Brightness: độ sáng 

- Start Color và End Color: màu của vùng toả sáng. 

- Fade: làm mờ vùng toả sáng. 

 

♦ Color Emboss : khắc chạm hình có màu.  

- Direction : hướng. 

- Relef : độ nổi. 

- Contrast: điều chỉnh độ tương phản. 

- Blend with Original: trộn với ảnh gốc. 

 

♦ Emboss : khắc chạm hình không màu. 

♦ Find Edges : nhấn mạnh cạnh hình. 

♦ Mosaic : nổi ô ca rô. 

- Horizontal Block : số điểm ảnh theo chiều ngang. 

- Vertical Block : số điểm ảnh theo chiều dọc. 

 

♦ Noise : tạo nhiễu lấm chấm trên hình. 

♦ Replicate : tạo nhiều hình giống nhau. 

♦ Solarize : chạy sáng. 

♦ Threshold : thềm. 
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Video 2 
Video 1 

Ảnh có kênh alpha 
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♦ Strobe light : chớp sáng. 

- Strobe color : màu ánh sáng chiếu. 

- Strobe Duration : thời lượng ánh sáng chớp. 

- Strobe Period : chu kỳ lặp lại. 

- Random Strobe Probability: độ chớp ngẫu nhiên. 

♦ Textfurize : tạo mẫu gạch. 

♦ Tiles : lát gạch. 

♦ Wind : Tạo hiệu ứng gió thổi. 

Một số hình ảnh minh hoạ: 
 

Brightness and Contrast  

Clip 

Color Balance 

 Extract 

Camera Blur 

Crop 

 
Emboss 

 
Gaussian Blur 



 
 
Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 109 
 
 

 Find Edges 

Horizontal Flip 

Invert 

Mosaic 

Pointillize 

Radial Blur 

Spherize 

Posterize 

Lens Flare 

Pinch 

Replicate 

Sharpen 
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Shear 

Tiles 

Solarize 

Zig Zag 

 

6.5. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Áp dụng các kỹ xảo có sẵn của chương trình vào Clip 

- Cung cấp một số hiệu ứng kỹ xảo. 

 
Bài tập 8 Tạo hiệu ứng (kỷ xảo) 

1- Khởi động chương trình Premiere 

2- Mở  baitap7.prproj 

3- Chọn Save As lưu lại với tên Baitap8.Prproj. 

4- Vào menu Window chọn Effects. 

Bấm vào dấu  trước Video Effects để mở rộng nó. 

5- Bấm vào dấu  trước Distort để mở rộng nó. 

6- Kéo hiệu ứng Twirl từ cửa sổ Effects thả vào Clip tiêu đề “SẮC MÀU CUỘC 
SỐNG”. 

7- Chuyển con chạy thời gian đến vị 
trí 1 giây, click vào biểu tượng  
trước Anggle. 

8- Chuyển con chạy thời gian đến vị 
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trí 2 giây nhập 1 x 00 vào Angle. 

9- Chuyển con chạy thời gian đến vị trí 3 giây nhập 0 x 00. 

10- Nhập 50% vào Twirl Radius 

11- Nhấn phím Home để con chạy chuyển về đầu Clip. 

12- Nhấn thanh Space Bar để xem. 

13- Vào menu File chọn Save để lưu Project lại. 

 

Bài tập 9 (tạo hiệu ứng) 

1- Khởi động chương trình Premiere 

2- Mở  baitap8.prproj 

3- Chọn Save As lưu lại với tên Baitap9.Prproj. 

4- Vào menu Window chọn Effects. 

Bấm vào dấu  trước Video Effects để mở rộng nó. 

5- Bấm vào dấu  trước Perspective để mở rộng nó. 

6- Kéo hiệu ứng Basic 3D từ cửa sổ Effects thả vào Clip mini_color_Match.avi. 

7- Chuyển con chạy thời gian đến vị trí 1 giây, click vào biểu tượng  trước 
Swivel. 

8- Chuyển con chạy thời gian đến vị trí 2 giây tại Swivel nhập 1 x 00.  

9- Nhấn phím Home để con chạy chuyển về đầu Clip. 

10- Nhấn thanh Space Bar để xem. 

11- Vào menu File chọn Save để lưu Project lại. 
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BÀI 7 

 CHỒNG HÌNH ẢNH 

 
Mục tiêu: 

Giúp học viên tìm hiểu quá trình ghép hình, chồng các hình 
ảnh lên nhau để tạo các hiệu ứng mong muốn. 
 
Thời gian thực hiện 
  5 tiết hoàn thành, kể cả thời gian ôn luyện và thực tập 
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7.1. Khái niệm trong suốt. 

Đây là phần kỹ xảo giúp chúng ta thấy cùng lúc nhiều hình ảnh, thông qua độ 
trong suốt của hình ảnh trên để thấy được hình ảnh dưới (ghép hình). 

Việc dựng Video thường ghép nhiều hình  ảnh lại với nhau vì vậy cần có 
những vùng trong suốt trong hình ảnh. Nhưng vì theo mặc định các frame video 
hoàn toàn không trong suốt do đó phải tạo ra các vùng trong suốt và các thông tin 
về vùng trong suốt này được lưu trữ trong kênh alpha của Clip. 

 

7.2. Các thao tác cơ bản. 

1- Sử dụng các key. 

- Sắp xếp hình ảnh song song trên cửa sổ Timeline. 
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 - Vào menu Window > Effect. 

 - Trong Effect chọn mục Video Effects sau đó chọn 
mục Keying. 

 - Kéo hiệu ứng cần sử dụng (hình 50) xuống cửa sổ 
Timeline với Clip video nằm ở track Video trên. 
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2- Hiệu chỉnh kỹ xảo. 

- Chọn Window > Effect Controls. 

 - Click vào tam giác trước tên của key để mở rộng nó. 

 - Điều chỉnh các mục cần thiết của key. 
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3- Sử dụng các Key. 

♦ Chroma Key : làm trong suốt một dải màu trong Clip.  

- Chọn Chroma key, kéo thả vào Clip cần làm trong suốt. 

- Vào menu Windown, chọn Effect Controls để mở cửa sổ Effect Controls. 

- Chọn màu cần làm trong suốt bằng 
cách click vào ô Color (hình 51) để chọn màu, 
hoặc chọn công cụ  nằm cạnh ô màu sau đó 
đưa con trỏ vào vùng màu cần tạo trong suốt ở 
cửa sổ Monitor, click chuột. 

- Điều chỉnh các thông số cần thiết: 

° Similarity : tăng/giảm dải màu 
được chọn làm trong suốt. Giá 
trị lớn làm tăng vùng màu. 

° Blend : trộn Clip keying với 
Clip bên dưới. 
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° Threshold : điều khiển mức độ bóng đổ trong dải màu đã tạo trong 
suốt. Giá trị càng lớn càng giữ nhiều bóng đổ. 

° Cutoff : làm sáng hoặc tối các bóng. Kéo sang phải để làm tối, nhưng 
đừng kéo vượt quá con trượt của Threshold; điều này làm đảo các 
pixel xám và các pixel trong suốt. 
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°  Smoothing: chỉ định mức độ răng cưa của đường viền giữa vùng 
trong suốt và vùng không trong suốt. 

° Mask Only: Chỉ hiển thị kênh alpha của Clip. 

 

♦ RGB Difference Key : dạng đơn giản của Chroma Key. Có thể chọn một dải 
màu nhưng không thể trộn với hình ảnh bên dưới. Sử dụng RGB Difference Key 
cho các khung hình có ánh sáng chói và không có bóng đổ hoặc cho các khung hình 
cắt thô không cần tinh chỉnh 

° Similarity : tăng / giảm dải màu được chọn làm trong suốt. Giá trị lớn 
làm tăng vùng màu. 

° Smoothing: chỉ định mức độ răng cưa của đường viền giữa vùng 
trong suốt và vùng không trong suốt. 

° Mask Only: Chỉ hiển thị kênh alpha của Clip. 

° Drop Shadow: tăng 50% mức xám  bằng cách dời 50% bóng mờ 
vùng mờ đục của ảnh gốc. Tuỳ chọn này làm việc tốt nhất với các 
hình ảnh đơn giản như Title chẳng hạn. 

 

♦ Blue Screen & Green  Screen Key : tạo trong suốt từ vùng màu xanh lơ 
(Blue) hoặc xanh lục (Green). 

° Threshold : kéo qua trái đến khi vùng màu lơ hoặc màu lục trở thành 
trong suốt. 

° Cut off : kéo qua phải cho đến khi vùng đục đạt tới mức độ cần thiết. 

 

♦ Non – Red Key : tương tự như Blue Screen & Green Screen Key nhưng có thể 
trộn với hình dưới nhờ loại bỏ đường viền của các đối tượng mờ đục. 

° Threshold : điều khiển mức độ bóng đổ trong dải màu đã tạo trong 
suốt. Giá trị càng lớn càng giữ nhiều bóng đổ. 

° Cutoff : làm sáng hoặc tối các bóng. Kéo sang phải để làm tối, nhưng 
đừng kéo vượt quá con trượt của Threshold; điều này làm đảo các 
pixel xám và các pixel trong suốt. 
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° Defringing:Xoá bỏ các đường viền xanh lơ hoặc xanh lục của các đối 
tượng trong Clip. 

° Smoothing: chỉ định mức độ răng cưa của đường viền giữa vùng 
trong suốt và vùng không trong suốt. 

° Mask Only: Chỉ hiển thị kênh alpha của Clip. 

 

♦ Luma Key : làm cho phần tối của ảnh trở thành trong còn phần sáng của ảnh 
trở thành đục. 

° Threshold: điều chỉnh  giá trị vùng tối trở thành trong suốt, giá trị cao 
làm tăng vùng trong suốt. 

° Cut off : chỉnh vùng đục, kéo qua phải để tăng độ trong. 

 

Lưu ý: cũng có thể sử dụng Luma key để làm trong suốt vùng sáng bằng cách đặt 
trị số Threshold nhỏ còn trị số của Cutoff lớn. 

 

♦ Multiply & Screen Key :  

- Multiply và Screen key dựa vào hình ảnh bên dưới để xác định phần 
nào của hình ảnh sẽ trở thành trong suốt. 

- Multiply : tạo vùng trong suốt tương ứng với vùng sáng của ảnh dưới. 

- Screen : tạo vùng trong tương ứng với vùng tối của ảnh dưới. 

° Opacity: kéo sang phải cho đến khi độ mờ đục  đạt đến mức độ cần 
thiết. Giá trị lớn càng ít trong suốt. 

° Cutoff : kéo qua phải để cho đến khi độ mờ đục đạt đến mức độ cần 
thiết. Giá trị lớn càng ít trong suốt. 

 

♦ Image Matte Key : dùng ảnh tĩnh làm mặt nạ để tạo vùng trong suốt. 

(Matte là một file ảnh tĩnh cụ thể để xác định nơi áp dụng hiệu ứng cho Clip) 

- Chọn Image Matte trong Keying. 
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° Setup :Click vào chọn ảnh tĩnh.  

° Composite Using: Chọn Matte Alpha để sử dụng cho ảnh có kênh 
alpha. Chọn Matte Luma cho ảnh đen trắng. 

° Reverse: đảo ngược hình ảnh giữa hai Clip.  

 

♦ Track Matte key : dùng làm mặt nạ để tạo vùng trong suốt. 

 

4- Sử dụng Opacity 

Chồng hình mờ:  

Ngoài cách chồng hình nói trên, ta có thể thực hiện chồng hình bằng cách: 

Trên cửa sổ Timeline 
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° Mở rộng track 

° Click vào biểu tượng có hình ,  sau đó chọn 
Show Keyframes. 

° Sử dụng công cụ Pen Tool  để xê dịch dây màu 
vàng trong Clip. 
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Trên cửa sổ effect Controls 

° Nhấn chọn mục Opacity  

° Hạ thấp tỷ lệ % xuống 
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Fade 

° Chọn công cụ  hoặc cũng có 
thể đánh dấu trong cửa sổ 
Effect Controls. 

° Sử dụng công cụ Pen Tool để 
điều chỉnh theo ý muốn. 
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7.3. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Nắm bắt và hiểu được khái niệm trong suốt. 

- Hiểu được cơ chế hoạt động của key 

- Khái niệm các loại key. 

- Cách sử dụng Opacity 

 

Câu hỏi ôn tập 

- Hãy trình bày khái niệm trong suốt. 

- Nêu những điểm khác nhau và giống nhau giữa các loại key. 

 

Bài tập 10 (chồng hình) 

1- Khởi động chương trình Adobe Premiere Pro 

2- Tạo một dự án mới với các thông số như hình sau: 

 

 
 

3- Vào menu File chọn Import hoặc nhấn Ctrl - I nhập các Clip sau: Polo 



 
 
Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 119 
 
 

85.avi và Carmen.avi. 

4- Kéo Clip Polo 85.avi từ cửa sổ Project vào track video 1 trên cửa sổ Timeline. 

5- Kéo Clip Carmen.avi từ của sổ Project vào track video 2 trên của sổ 
Timeline, chồng lên trên Clip Polo 85.avi. 

6- Vào menu File chọn New chọn  Title hoặc nhấn phím F9 để mở cửa sổ 
Adobe Title Designer. 

 

7- Vẽ hình chữ nhật với 
kích thước  

width = 305,   

Height = 203  

và tọa độ  

X Position = 450,  

Y Position = 175 
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8- Nhắp nút phải chuột lên 
hình chữ nhật di chuyển 
chuột đến Graphic Type 
chọn Open Bezier, để 
hình chữ nhật chỉ còn 
đường viền. 

 
 

 

 
 

 

9- Lưu hình trên với tên HCN.prtl. 

10- Đóng cửa sổ Adobe Title Designer để trở lại Premiere. 
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BÀI 8 

CÁCH TẠO CHỮ 

 
 

Mục tiêu: 

- Cách tạo chữ trên nền Video. 

- Các công cụ hỗ trợ cho việc tạo chữ. 

Mục tiêu: 

5 tiết hoàn thành, kể cả thời gian ôn luyện và thực tập 
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8.1. Khởi động 

- Vào Menu File > New > Title. 

- Khi cửa sổ xuất hiện, ta có thể nhập những dòng chữ tuỳ thích. 

- Trong cửa sổ Title sẽ xuất hiện những mục sau: 
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- Font : chọn Font chữ. 

- Font Size : kích cỡ của chữ. 

- Aspect : tỷ lệ kích thước theo chiều 
ngang của Font chữ. 

- Leading : khoảng cách giữa hai dòng. 

- Kerning : điều chỉnh khoảng cách giữa 
hai ký tự cặp đôi. 

- Tracking : khoảng không gian của nhóm 
chữ. 

- Baseline Shift : dời đường chân. 

- Slant : nghiêng. 

- All Caps : đổi chữ thường thành chữ in hoa. 
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- Small Caps Size : kích thước chữ hoa nhỏ. 

- Underline : gạch dưới chữ. 

- Distort : làm méo. 

 

8.2. Các công cụ 
 

Thanh công cụ của Adobe Title Designer trong Adobe Premiere Pro 1.5 

 

  : chọn đối tượng 

  : gõ chữ ngang 

 : đoạn chữ ngang 

 : chân chữ name trên Path 

   : vẽ đường cong 

  : xoá điểm neo 
 

 : xoay đối tượng 

 : gõ chữ dọc 

 : đoạn chữ dọc 

 : cạnh chữ nằm trên Path 

 : thêm điểm neo 

 : biến đổi điểm neo 

A : canh thẳng hàng theo chiều 
nằm ngang bên trái 

B : canh thẳng hàng ở giữa 

C : canh thẳng hàng theo chiều 
nằm ngang bên phải 

D : chia đều khoảng cách dựa 
vào cạnh trái của các đối tượng 
theo chiều ngang 

E : chia đều khoảng cách ở 
giữa theo chiều ngang 

F : chia đều khoảng cách dựa 
vào cạnh phải theo chiều ngang 

G : Chia các khoảng trống đều 
nhau theo chiều ngang. 

 

H : canh thẳng hàng theo cạnh 
trên 

I : canh thẳng hàng giữa tâm 

J : canh thẳng hàng theo cạnh 
dưới  

K : chia đều khoảng cách dựa 
vào cạnh trên theo chiều đứng 

L : chia khoảng cách ở giữa 
theo chiều đứng 

M :chia đều khoảng cách dựa 
vào cạnh dưới theo chiều đứng 

N : chia các khoảng trống đều 
nhau theo chiều đứng 
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8.3. Mở file hoặc tạo file mới  

1- Tạo file mới và lưu (save) file : 

- File  New  Title hoặc nhấn phím F9 

- File  Save (hoặc Save As) 

- Xác định vị trí để lưu và đặt tên. 

2- Mở file : 

- File  Open. Hộp thoại Open xuất hiện. 

- Xác định vị trí chứa file đã lưu 

- Click chọn tên file và click Open 

3- Hiệu chỉnh file Title trong Project đang làm việc 

- Double click vào biểu tượng file Title trong cửa sổ project hoặc trên Timeline 

 

8.4. Làm việc với file mới 

1- Chỉnh giá trị bằng cách dùng “hot text” 

- Đặt con trỏ vào giá trị có gạch dưới, bấm giữ chuột và kéo sang phải hoặc 
trái để tăng, giảm giá trị (nhấn giữ phím shift và kéo chuột để tăng hoặc giảm 
nhanh). 
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- Click chuột vào ô giá trị rồi gõ giá trị trực tiếp vào trong đó. 
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2- Dùng templates 

- Mở template bằng 2 cách 

+ Click vào nút template  (phím tắt Ctrl – J) 

+ Vào menu Title  templates, hộp thoại templates xuất hiện. 

+ Chọn một template rồi nhấn nút Apply 

 

 

Hình  116 

 

- Tạo 1 template từ  file Title đang mở:  

  + Title  templates  chọn folder muốn save. 

  + Click   chọn save <filename> as template. Hình  117 
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- Nhập 1 file đã lưu thành template 

  - Title  template. 

  -   Import file as template 

  - Chọn file, Open. 
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- Chọn template mặc định 

  + Title  templates  chọn một template. 

  + Click    chọn Set template as default. Hình  119 

- Đặt lại tên cho một template 

  + Title  templates  chọn một template. 

  + Click vào    chọn Rename template 
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 - Xoá template 

  + Title  templates  chọn một template. 

  + Click vào    Chọn delete template 
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3- Hiển thị Video dưới Title 

- Hiện hoặc tắt Video: Chọn show video  
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- Hiển thị frame tại vị trí xác định: Thay đổi giá trị bên cạnh show video. 

  

Hình  123 

 

- Hiển thị một frame ngay tại vị trí con trỏ trên Timeline: Sync to Timeline  
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8.5. Làm việc với Fill, Sheen, Texture 

1- Fill: Tô màu cho đối tượng. 

- Chọn đối tượng. 

- Click vào dấu tam giác trước mục Fill và thiết lập các mục sau: 

 

2- Fill Type : chọn kiểu tô màu 

� Solid : tô bằng một màu 

� Linear Gradient and Radial Gradient : tô 
bằng hai màu chuyển tiếp 

� 4_Color Gradient: tô chuyển tiếp với bốn màu 

� Bevel : tô màu tạo khối 

� Eliminate : không tô màu, không tạo bóng. 

� Ghost : không tô màu, có bóng. 
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3- Color: chọn màu  

 

4- Opacity: độ mờ của đối tượng, khi giảm Opacity 
các đối tượng sẽ mờ dần làm hiện các đối tượng 
khất phía sau. 
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5- Sheen: Tạo một đường sáng ngời 

- Chọn  đối tượng. 
- Vào Sheen. 

� Color : màu Sheen 
� Opacity : độ mờ đục  
� Size : kích thước của Sheen Hình  127 

� Angle : góc quay 

� Offset : độ dời 



 
 
Giáo trình Ứng dụng tin học trong sản xuất chương trình truyền hình 128 
 
 
6- Texture : 

Tô màu bằng hình ảnh 

� Chọn đối tượng. 

� Chọn hình ảnh bằng cách đánh dấu vào ô Texture, 
rồi chọn ô vuông Texture đã được mở rộng. 

� Thay đổi các thông số. 
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7- Stroke: Tạo viền 

- Chọn đối tượng. 

- Click vào Add ở Inner Stroke để tạo đường viền bên 
trong hoặc Outter Stroke để tạo đường viền bên ngoài. Hình  129 

- Click vào hình tam giác trước các Stroke để thay đổi 
các tham số. 

� Type: kiểu Stroke. Depth tạo khối có chiều sâu. Edge tạo 
viền dạng cạnh quanh đối tượng. Drop Face tạo bản 
sao của đối tượng dời nhưng dịch chuyển đi. 

Hình  130 

� Size: kích thước của stroke. 

� Angle: góc lệch của đối tượng. 

� Magnitude: chỉ định chiều cao của Stroke. 
Tuỳ chọn này chỉ có tác dụng đối với kiểu 
Drop Face. 

� Fill type: kiểu tô màu cho stroke (giống Fill).  
Hình  131 
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8.6. Làm việc với Shadow (bóng đổ) 

- Chọn đối tượng. 

- Chọn Shadow. 

- Thay đổi các thông số. 

� Color : màu của bóng đổ 

� Opacity : độ mờ đục 
Hình  132 

� Angle : góc quay 

� Distance : độ dời 

� Size : kích thước 

� Spread : độ mờ 

 

8.7. Thay đổi thuộc tính Font 

1- Thay đổi chữ 

- Chọn chữ. 

 - Thực hiện một trong các 
cách sau: 

 + Vào Title > Font > 
 Chọn font chữ cần 
 thiết 
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+ Vào Title > Font > Browse > chọn font > OK 

- Chọn một Font từ Object Style Properties 

2- Thay đổi cỡ chữ 

- Chọn chữ. 

- Thực hiện một trong các cách sau: 
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- Vào Title > Size > Size 

- Thay đổi cỡ chữ trong Object Style 

- Canh lề cho chữ 

- Chọn Text. 

- Vào Title > Type Alignment  

- Sau đó chọn Left, Right hoặc Center. 
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8.8. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Thực hiện tạo chữ theo mẫu có sẵn. 

- Thực hiện tạo chữ với các công cụ Fill, Sheen, Texture, Shadow, … 
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BÀI 9 

CAPTURE VÀ XUẤT PHIM 

 

 

 
Mục tiêu: 

- Thực hiện đưa Video từ băng từ (Tape) vào máy tính 

- Xuất Project hoàn chỉnh thành tập tin Video và ghi ra băng từ. 

 

Thời gian thực hiện 

 5 tiết hoàn thành, kể cả thời gian thực tập. 
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9.1. Capture 

Capture đưa những những cảnh quay, những đoạn phim trực tiếp từ Camera 
hoặc trên băng từ  vào ổ đĩa cứng của máy tính. 

Trong khi đang Capture, ta vẫn có thể làm việc với những chương trình khác 
mà không cần phải chờ cho máy tính Capture xong. 

1- Các bước chuẩn bị 

Vào menu File chọn Capture hoặc nhấn phím F5. 

Hộp thoại Capture xuất hiện, click vào Tab setting sau đó click vào nút Edit. 
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Hộp thoại Poject Setting xuất hiện, Click vào chữ Capture. 

Trong Capture format, chọn tên của Card Capture. (Hình 136 - 137) 
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Hình  136 

 

Hình  137 

 

Nhấn vào nút A/V Input 

 

 
Hình  138 

 
 

Nếu sử dụng cáp nối tín hiệu là S-Video 
(Hình 140) thì chọn S-Video; nếu sử dụng cáp 
nối tín hiệu tổng hợp (jack bông sen) thì chọn 
Composite. Nếu sử dụng cáp nối là DV (Digital 
Video) hay còn được gọi là Cáp  IEEE 1394 thì 
chọn IEEE 1394 hoặc chọn theo tên của Card 
Capture. Ví dụ Pinnacle, Matrox, … (hình 141) 

Hình  139 

 

 

Hình  140 
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Trong phần Capture Location 

Click vào nút Browse ở Video, chọn thư 
mục lưu trữ cho file Video. Nếu muốn đặt 
trong thư mục tạo Project thì Same as Project. 

Click vào nút Browse ở Audio, chọn 
thư mục lưu trữ cho file Audio. Nếu muốn đặt 
trong thư mục tạo Project thì Same as Project. Hình  142 

Trong Divice Control, chọn thiết bị 
điều khiển Capture là Card Capture tương 
ứng đang được chọn 

.

Hình  143 

 

2- Capture từ một điểm. 

Để bắt đầu thu, tìm đến điểm bắt đầu thu trên băng, Click vào nút Record ( ) để 
bắt đầu thu.. 

Để dừng thu, nhấn phím ESC trên bàn phím. 

Đặt tên cho đoạn tín hiệu vừa capture. 
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3- Capture trong một đoạn có xác định điểm bắt đầu và kết thúc. 

Trường hợp muốn capture một 
đoạn trong một khoảng thời gian nào 
đó, ta thực hiện như sau: 

Click vào thẻ Logging  trên cửa sổ 
Capture 
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Tìm đến điểm đầu của đoạn băng 
cần capture, nhấn nút Set In. 

Tìm đến điểm cuối của đoạn băng 
cần capture, nhấn nút Set Out. 
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 Nhấn vào nút In/Out để bắt đầu 
capture 

 Máy tính sẽ điều khiển tự động 
thiết bị để capture đoạn vừa đánh dấu. 

 

Hình  146 
 

 

9.2. Xuất phim 
1- Xuất thành file phim 

Click chọn cửa sổ Timeline. 
Vào menu File chọn Export, chọn tiếp Movie hoặc nhấn tổ hợp phím tắt Ctrl – M. 
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Hộp thoại Export Movie xuất hiện (hình 148). 
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Chọn nơi lưu trữ file muốn xuất ở Save in. 
Đặt tên File muốn xuất ở khung File Name. 
Click vào nút Setting để thiết lập các thông số cho file xuất. Hộp thoại Export 

Movie Setting xuất hiện (hình 148). 
Trong File Type, chọn kiểu file muốn xuất (hình 149), ví dụ file *.avi, *.bmp, … 
Trong Range, Chọn Entire Sequence (hình 151) để xuất toàn bộ những cảnh đã 

dựng trên Timeline thành file phim. Chọn Work Area Bar để chỉ xuất trong vùng thanh 
làm việc. 
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Click OK để đóng hộp thoại Export Movie Setting. 
Trở lại hộp thoại Export Movie. Click nút Save để xuất và lưu file. 
 

2- Xuất thành file ảnh 
Trong trường hợp muốn lưu một frame nào đó thành một file ảnh, ta thực hiện 

như sau: 
Trên cửa sổ Timeline, chuyển thanh trượt thời gian tới muốn lưu thành file ảnh. 
Vào menu File chọn Export, chọn Frame hoặc nhấn tổ hợp phím Ctrl – Shift – M. 
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Hộp thoại Export Frame xuất hiện 
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Chọn nơi lưu trữ file muốn xuất ở Save in. 
Đặt tên File muốn xuất ở khung File Name. 
Click vào nút Setting để thiết lập các thông số cho file. 
Click nút Save để xuất và lưu file. 
 

3- Xuất ra băng: 
Click chọn cửa sổ Timeline. 
Vào menu File chọn Export, chọn tiếp Export to tape hoặc nhấn tổ hợp phím 

tắt Ctrl – Shift - M. 
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Hộp thoại Export to Tape xuất hiện: 

Đánh dấu  vào Activate 
Recording Device 

Nhấp vào nút Record để bắt 
đầu ghi. 

Hình  155 

9.3. Tóm tắt và ôn luyện 
Những gì bạn học trong phần này 

- Các thao tác capture 

- Các thao tác xuất phim 

Câu hỏi ôn tập 

So sánh với chương trình Ulead Video Studio 9.0, quá trình Capture và xuất 
phim có điểm gì giống và khác nhau ? 
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